OvenRIDER® NL
Hardware & Software Users Guide

OvenRIDER® NL
Reflow Oven Analyzer
A45-6836-00

Rev 1.1

SINCE 1964

ECD
4287-B S.E. International Way
Milwaukie, Oregon 97222-8825
Telephone: (800) 323-4548
(503) 659-6100
FAX: (503) 659-4422
Technical Support: (800) 323-4548
Email: ecd@ecd.com
Internet: http://www.ecd.com

Copyright 2005-2008 ECD All Rights Reserved. Printed in USA Foreign and US Products of ECD are covered by
foreign and US Patents and Patents Pending. Information in this publication supersedes all previously published
information. This Publication may not be translated and/or reproduced or stored in data retrieval system, or
transmitted in any form or by any means without the express written permission of ECD Specification and price
change privileges reserved.
The trapezoidal ECD logo, OvenRIDER® and M.O.L.E. ® (Multi Channel Occurrent Logger Evaluator) are registered
trademarks of ECD MS-DOS and Windows are registered trademarks of Microsoft Corporation. IBM, IBM PC and
PS/2 are registered trademarks of International Business Machines Corporation.
The OvenRIDER® product is covered by U.S. Patent Numbers: 6,062,728; 6,375,351; 6,520,675

TABLE OF CONTENTS
Introduction ................................................................................................................. vii
y How to Use This Manual ........................................................................................ vii
y Terms used in this Manual .................................................................................... viii
y Fonts Used in this Manual..................................................................................... viii
• Product Symbols .....................................................................................................ix
y Cleaning Instructions...............................................................................................ix
Operators Safety Information....................................................................................... x
y Computer Hardware Requirements.........................................................................xi
1.0 System Description................................................................................................. 1
1.1 OvenRIDER Description ...................................................................................... 2
1.2 Zone Boundary Magnets...................................................................................... 4
1.3 OR SPC Software Description ............................................................................. 5
2.0 Setup and Configuration ........................................................................................ 6
2.1 Zone Boundary Magnet Installation ..................................................................... 6
2.2 Software Installation............................................................................................. 9
2.3 Communication Setup........................................................................................ 10
3.0 Operation ............................................................................................................... 12
• Step 1 - Data Collection Setup .............................................................................. 12
• Step 2 - Data Collection ........................................................................................ 14
• Step 3 - Data Transfer........................................................................................... 17

OvenRIDER® NL

♦i♦

4.0 OR SPC Software .................................................................................................. 19
4.1 OR SPC Workbook Features ............................................................................. 19
4.2 Standard Worksheet functions ........................................................................... 21
4.2.1 Worksheet tabs.......................................................................................... 21
4.2.2 Selecting Worksheets ................................................................................ 21
4.2.3 Split-bar ..................................................................................................... 21
4.2.4 Worksheet Tab Scroll Arrows .................................................................... 21
4.2.5 Scrollbars................................................................................................... 22
5.0 Worksheet Descriptions ....................................................................................... 23
5.1 Welcome Worksheet.......................................................................................... 23
5.1.1 Welcome Worksheet Menus and Toolbar.................................................. 24
5.1.2 Company Name......................................................................................... 25
5.2 OvenRIDER Data Worksheet............................................................................. 26
5.2.1 OvenRIDER Data Worksheet Menus and Toolbar Buttons ....................... 27
5.2.2 Interpreting the OvenRIDER Data Sheet ................................................... 28
5.2.3 Data Coloring and LSL / USL .................................................................... 29
5.3 Spreadsheet Worksheet .................................................................................... 30
5.3.1 Spreadsheet Menus and Toolbar Buttons ................................................. 31
5.3.2 Parameter Group Row............................................................................... 32
5.3.3 Parameter Labels ...................................................................................... 34
5.3.4 Parameter Units......................................................................................... 34
5.3.5 Data Run Rows ......................................................................................... 35
5.3.6 Selected Run ............................................................................................. 35
5.3.7 Filters......................................................................................................... 36
5.3.8 Statistics .................................................................................................... 39
5.4 Profile Worksheet............................................................................................... 40
5.4.1 Profile Menus and Toolbar Buttons ........................................................... 41
5.4.2 M.O.L.E. Status ......................................................................................... 42
5.4.3 Tool Status ................................................................................................ 43
5.4.4 Magnify Map .............................................................................................. 43
5.4.5 The Data Table.......................................................................................... 44
5.4.5.1 Value Pop-up ................................................................................. 45
5.4.5.2 Show/Hide Columns....................................................................... 46
5.4.5.3 Change Summary Stats Settings ................................................... 47
5.4.5.4 Change Slope Calculator ............................................................... 48
5.4.6 Sensor Locations....................................................................................... 49
5.4.7 Channel Check Boxes ............................................................................... 49
5.4.8 Status Bar.................................................................................................. 50

♦ii♦

OvenRIDER® NL

5.4.9 Data Tabs .................................................................................................. 51
5.4.9.1 Value.............................................................................................. 51
5.4.9.2 Time to Reference ......................................................................... 52
5.4.9.3 T Above Ref ................................................................................... 52
5.4.9.4 Statistics......................................................................................... 54
5.4.9.5 Summary Statistics ........................................................................ 54
5.4.9.6 KPI (Key Process Indicators) ......................................................... 54
5.4.10 The Data Graph....................................................................................... 56
5.4.10.1 X and Y-Axes and Labels............................................................. 56
5.4.10.2 Autoscaling .................................................................................. 57
5.4.10.3 Data Plots .................................................................................... 58
5.4.10.4 Process Origin ............................................................................. 60
5.4.10.5 X-Cursors..................................................................................... 61
5.4.10.6 X-axis Units.................................................................................. 63
5.4.10.7 Temperature Reference Lines ..................................................... 64
5.4.10.8 Zones and Zone Sizes ................................................................. 64
5.4.10.9 Zone Temperatures...................................................................... 64
5.4.10.10 Zone Matrix ................................................................................ 65
5.5 Administration Worksheet .................................................................................. 66
5.5.1 Admin(istration) Menus and Toolbar Buttons............................................. 67
5.5.2 Spreadsheet Parameters........................................................................... 68
5.5.3 Spreadsheet Parameters View check boxes ............................................. 68
5.5.4 Specification and Control Limit Cells ......................................................... 69
• LSL and USL Cells .................................................................................. 69
• User Controlled LSL and USL ................................................................. 70
• LCL and UCL Cells.................................................................................. 71
• User Controlled LCL and UCL................................................................. 71
5.5.5 SPC Sheet Boxes ...................................................................................... 72
5.6 Guide Worksheet ............................................................................................... 75
5.7 SPC Worksheet ................................................................................................. 76
5.7.1 Menus & Toolbar ....................................................................................... 77
5.7.2 X-Bar Chart................................................................................................ 78
5.7.3 R Chart ...................................................................................................... 79
5.7.4 Statistics Box ............................................................................................. 80
5.7.5 Renaming SPC Worksheets ...................................................................... 81

OvenRIDER® NL

♦iii♦

6.0 Menu and Tool Commands .................................................................................. 82
6.1 File Menu ........................................................................................................... 82
6.1.1 New Workbook .......................................................................................... 82
6.1.2 Open Workbook......................................................................................... 84
6.1.3 Close Workbook ........................................................................................ 84
6.1.4 Import ........................................................................................................ 85
6.1.5 Save Workbook ......................................................................................... 86
6.1.6 Save Workbook As .................................................................................... 86
6.1.7 Save As Text ............................................................................................. 87
6.1.8 Save as Text Archive................................................................................. 87
6.1.9 Load Text Archive...................................................................................... 88
6.1.10 Configuration ........................................................................................... 89
6.1.11 Preferences ............................................................................................. 90
6.1.11.1 Units........................................................................................... 90
6.1.11.2 Passwords ................................................................................. 91
6.1.11.3 File Tag Number ........................................................................ 95
6.1.12 Print Options............................................................................................ 96
6.1.13 Page Setup.............................................................................................. 97
6.1.14 Page Header / Footer .............................................................................. 98
6.1.15 Print Preview ........................................................................................... 99
6.1.16 Print ....................................................................................................... 100
6.1.17 Report Setup ......................................................................................... 101
6.1.18 Print Report ........................................................................................... 101
6.1.19 Send to Mail Recipients ......................................................................... 102
6.1.20 Recent Files 1, 2, 3, etc... ...................................................................... 103
6.1.21 Exit......................................................................................................... 103
6.1.22 Language............................................................................................... 103
6.2 Edit Menu......................................................................................................... 104
6.2.1 Undo ........................................................................................................ 104
6.2.2 Redo ........................................................................................................ 104
6.2.3 Copy ........................................................................................................ 104
6.2.4 Paste ....................................................................................................... 104
6.2.5 Remove Row ........................................................................................... 105
6.2.6 Hide Row ................................................................................................. 105
6.3 View Menu ....................................................................................................... 106
6.3.1 Zoom In ................................................................................................... 106
6.3.2 Zoom Out................................................................................................. 106
6.3.3 100% ....................................................................................................... 106
6.4 Format Menu.................................................................................................... 107
6.4.1 Bold ......................................................................................................... 107
6.4.2 Italic ......................................................................................................... 107
6.4.3 Underline ................................................................................................. 107
6.4.4 Alignment (Left, Center, Right) ................................................................ 107

♦iv♦

OvenRIDER® NL

6.5 Window Menu .................................................................................................. 108
6.5.1 Cascade .................................................................................................. 108
6.5.2 Tile........................................................................................................... 109
6.5.3 Open File ................................................................................................. 109
6.6 OvenRIDER Menu ........................................................................................... 110
6.6.1 Configuration Wizard ............................................................................... 110
6.6.2 Set M.O.L.E. Clock .................................................................................. 112
6.6.3 OvenRIDER Settings ............................................................................... 113
6.6.4 Read OvenRIDER Data........................................................................... 114
6.7 Profile Menu..................................................................................................... 115
6.7.1 Part .......................................................................................................... 115
6.7.2 Process.................................................................................................... 116
6.7.3 Scaling..................................................................................................... 117
6.7.4 Units ........................................................................................................ 118
6.7.5 Temp Ref Lines (Temperature Reference Lines) .................................... 119
6.7.6 Profile Colors ........................................................................................... 120
6.8 Tools Menu ...................................................................................................... 121
6.8.1 Magnify Tool ............................................................................................ 121
6.8.2 Slope Tool ............................................................................................... 123
6.8.3 Peak Difference Tool ............................................................................... 125
6.8.4 Overlay Tool ............................................................................................ 126
6.8.5 3-D View .................................................................................................. 128
6.8.6 Measure Tool........................................................................................... 130
6.8.7 Notes Tool ............................................................................................... 132
6.8.8 Erase Object(s)........................................................................................ 133
6.8.9 Erase All .................................................................................................. 133
6.9 Manual Zones .................................................................................................. 134
6.9.1 Manual Zone Definition............................................................................ 134
6.9.2 Setup Zones ............................................................................................ 136
6.10 Navigate Menu............................................................................................... 141
6.11 Help Menu...................................................................................................... 142
6.11.1 Help ....................................................................................................... 142
6.11.2 ECD on the Web.................................................................................... 142
6.11.3 About OvenRIDER ................................................................................ 142

OvenRIDER® NL

♦v♦

7.0 Service and Troubleshooting ............................................................................. 143
7.1 Zone Sensor Battery ........................................................................................ 143
7.2 Service Troubleshooting .................................................................................. 144
7.2.1 OvenRIDER Troubleshooting Steps ........................................................ 144
7.3 How to Get Additional Help .............................................................................. 145
Appendix A: Specifications...................................................................................... 146
Electrical/Mechanical: ............................................................................................ 146
Environmental ........................................................................................................ 146
Appendix B: Statistical Process Control (SPC) Background Information ........... 147
Appendix C: Measurement Definitions.................................................................... 153
Appendix D: OvenRIDER Accuracy and the Influencing Factors ......................... 155
Appendix E: Pull-Down Menus & Toolbar Buttons ................................................ 159
Appendix F: OvenRIDER NL Options and Accessories......................................... 162
OvenRIDER NL Options ........................................................................................ 162
OvenRIDER NL Accessories: ................................................................................ 163

♦vi♦

OvenRIDER® NL

Introduction
y How to Use This Manual
This User’s Guide explains how to use the OvenRIDER® NL System and software.
This manual is written for users of varied experience. If a section covers information you
already know, feel free to skip to the next section.
•

You do not need to be a computer expert to use this manual or the software.

•

The manual assumes you are familiar with Microsoft® Windows®.

The hardware portions of this manual are written to reflect SuperM.O.L.E. Gold
firmware versions 9.08 and higher. The software portions reflect versions 5.22
and higher.

The software is designed to be used with the SuperM.O.L.E. Gold only.

OvenRIDER® NL

♦vii♦

y Terms used in this Manual
ECD introduced the original M.O.L.E. ® (Multichannel Occurrent Logger Evaluator) in
1985. Since ECD has produced several models of the M.O.L.E. for use in a wide variety
of applications. In this manual, we may refer to the SuperM.O.L.E. ® Gold data
recording device as the M.O.L.E..
The following statements describe special terms that will be used in this manual.
•

Informs the user that the note includes important information.

•

Informs the user that the note includes a handy tip.

Hardware Terms:
•

Informs the user that the note identifies conditions or practices that
could result in damage to the equipment.

•

Informs the user that the note identifies conditions or practices that
could result in personal injury or damage to property other than the
equipment.

•

OvenRIDER® NL, refers to the OvenRIDER® reflow oven analyzer to be Lead-Free
process compatible.

•

Thermocouple, may be referred to as T/C.

Software Terms:
•

OvenRIDER® SPC software may be referred to as OR SPC.

•

Workbook, contains all of the worksheets and the uploaded data set saved with file
extension (.MOR).

•

Worksheet, the individual pages or sheets in the workbook file.

•

Data Set, multiple data runs uploaded into the workbook file.

•

Data Run / Experiment, the data uploaded from the M.O.L.E..

y Fonts Used in this Manual
This manual uses a special font to indicate terms or words that can be found directly on
the computer monitor.
For example: “Select the Open Workbook command from the File menu to open a new
workbook file”. This font indicates the words Open Workbook and File are actually found
on the computer display as menu items.
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• Product Symbols
The following symbols may be present on the Product:
•

Direct Current (DC) Power

•

Alternating Current (AC) Power

•

CAUTION: Whenever this internationally recognized symbol is used
on the product, additional information concerning that particular
feature or function appears in the manual.

•

Battery Charger protected throughout by double or reinforced insulation.

•

Indoor use only. For electric-shock protection, always operate the
battery charger in a protected, indoor location.

•

WARNING – Surfaces may be Hot!

y Cleaning Instructions
IPA alcohol is the only type of solvent that is acceptable to clean the any of the system
components. All other types are not recommended
To prevent product damage, do not clean the product using organic solvents.
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Operators Safety Information
The safety information in this summary is for the benefit of operating personnel.
Warnings and Cautions will also be found throughout the manual where they apply.
•

Hardware changes or modifications to the OvenRIDER NL components, is
not expressly approved by ECD, Inc. could void the product’s warranty.

•

Some components may be sensitive to magnetic fields. Although most standard
components are not, you should consult the manufactures specifications for
special precautions that may exist for the specific components you are
processing.

Battery Warnings:
•

Replace Zone Boundary Sensor battery with SAFT lithium 3.6V 1/2AA, or
equivalent.

•

Using another battery may present a risk of fire or explosion.

•

Battery may explode if mistreated.

•

Do not recharge, disassemble, or dispose of in fire.

•

Do not expose to temperature above 100°C (212°F)

•

Batteries contain electrolytes. Dispose of used batteries promptly and properly.

•

Keep batteries away from children.

For protection of the OvenRIDER NL components, observe the following:
•

Do not subject the OvenRIDER NL components to sharp impacts.

•

Do not excessively stress the PC serial cable.

•

Do not expose the OvenRIDER NL components to corrosive environments.

•

Do not expose the OvenRIDER NL above the specified maximum temperature.

The warranty will not cover damage caused by neglect or abuse of this product.
To maintain the safety features incorporated in this product, operation must be in
strict compliance with the requirements specified herein.
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y Computer Hardware Requirements
CPU, RAM, Hardware:

300mhz processor or equivalent
128 megabytes of RAM (minimum).
50 megabytes of free disk space.

Operating System:

Windows XP, 2000 & 98.

Disk Drive:

CD Rom drive.

Mouse:

Windows compatible mouse.

Communication Port:

Serial Port, USB (with supplied port replicator).

Video:

Color VGA or better video card and appropriate video
monitor. (SVGA is highly recommended)

It is recommended that the minimum computer display area be set to 800 x 600.
For best performance set the display to 1024 X 768 (Refer to your Microsoft®
Windows® documentation for details).
Printer:

OvenRIDER® NL

Color printer is recommended.
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1.0 System Description
OvenRIDER NL Profiles reflow oven capability, separating zonal temperatures from
convection efficiency while verifying conveyor speed for a true picture of oven LeadFree performance consistency. Ensuring oven capability for Lead-Free recipes is an
important task, and OvenRIDER NL is Lead-Free capable itself, with 50% more thermal
capacity than the previous model and a low 0.91"/23.1mm clearance height above the
chain conveyor.
Powered by SuperM.O.L.E.® Gold, ECD’s OvenRIDER® NL Reflow Oven Analysis
System is THE alternative to profiling “golden boards” for first-off use. Built-In Statistical
Process Control makes OvenRIDER NL a superior quality assurance tool, and there are
no thermocouples to attach. The patented OvenRIDER NL utilizes a combination of
thermal and position sensors to measure oven performance, delivering consistent colorcoded data that can be used to identify trends [SPC implementation] and serves as a
Go/No-Go indicator for the operator.

Figure 1-1: OvenRIDER NL System Block Diagram
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1.1 OvenRIDER Description
This section covers brief descriptions for the exterior and interior features of
OvenRIDER NL.
Exterior features:
•

Barrier box: This is the thermal protective barrier for the M.O.L.E.. This barrier
also is equipped with external insulation on the top and bottom, which provides
the extra thermal protection needed for Lead-Free processes.

•

Barrier locking latch: This latch secures the cover of the barrier to prevent it
from opening.

•

Zone sensor light: There is an LED porthole on the top of the barrier cover that
illuminates when the OvenRIDER NL detects zone boundary magnets.

•

Process and ambient sensors: These are 6 sensors that are used to collect
data.
LOCKING
LATCH

BARRIER BOX
AMBIENT
SENSORS

PROCESS
SENSORS

ZONE SENSOR LIGHT

Figure 1-2: OvenRIDER NL Exterior Features
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Internal Features:
•

Zone sensor battery: This is the power source for the zone sensor LED.

•

Connector bridge: This is where the M.O.L.E. plugs into the OvenRIDER for
data transfer from the process and ambient sensors.

•

M.O.L.E. extractor handle: This handle assists in the removal of the M.O.L.E..

•

Configuration plug: This plug configures the M.O.L.E. to operate in
“OvenRIDER” mode.

ZONE SENSOR BATTERY

M.O.L.E. EXTRACTOR HANDLE

CONFIGURATION PLUG

CONNECTOR BRIDGE

Figure 1-3: OvenRIDER NL Internal Features
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1.2 Zone Boundary Magnets
The OvenRIDER NL has reed switch sensors designed for locating zone boundaries.
These sensors are on both sides of the front and back edges of the pallet. The
OvenRIDER NL Kit includes a magnet kit for installing up to 13 zones the oven.
There are two different types of magnet clips designed to mount the magnets to the
reflow oven rail. Reflow ovens may have different conveyor rails, so determine which
type will best mount the magnets in your oven. Modifications to the clips may be
necessary to properly mount magnets.
“ELECTROVERT” CLIP
MAGNET

MAGNET

“P” CLIP

Figure 1-4: Magnet Clips
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1.3 OR SPC Software Description
The OR SPC software uses the worksheet tab format to access and analyze reflow
oven data. The illustration shown below displays the basic features for all of the
worksheets.
TITLE BAR
MENUS
TOOLBAR

WORKSHEET TABS
Figure 1-5: OR SPC Software

Basic Software Features:
•

Title Bar: This bar contains the program name, version, and the active workbook
file name.

•

Menus: These menus contain the commands for each worksheet. Each
worksheet may contain different commands to supply specific function for each
worksheet. Individual worksheet menus are described in detail in their specified
sections of this manual.

•

Toolbar: The Toolbar has buttons to serve as shortcuts to the menu commands.
Individual worksheet toolbar buttons are described in detail in their specified
sections of this manual. Each worksheet may have different items on the toolbar
because of the different features offered by each worksheet.

•

Worksheet Tabs: These tabs are used to gain easy access to each worksheet.

OvenRIDER® NL
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2.0 Setup and Configuration
This section will provides the necessary steps to setup and configure the hardware and
software to properly operate the OvenRIDER NL.
2.1 Zone Boundary Magnet Installation
The OvenRIDER NL has reed switch sensors designed for locating zone boundary
magnets that are mounted in the reflow oven. These sensors are on both sides of the
front and back edges of the pallet. The OvenRIDER NL Kit includes a magnet kit for
installing up to 13 zones the oven prior to operation.
Some components contain materials that are attracted to magnets (IC legs,
component leads, mounting hardware, etc). Although the magnets installed for
zone detection are relatively weak, they may attract these components if they get
less then 0.5 inches (12cm) from the magnets. If the components on the PCB are
too close, be sure they are well secured, or that they do not contain magnetic
material.
The Following steps assist you to properly install the zone boundary magnets:
When unpacking be careful not to sharply jar the magnets because it can weaken
their magnitization.
1. The zone boundary magnet kit is supplied with two different types of magnet clips
designed to mount the magnets to the reflow oven rail. Reflow ovens may have
different conveyor rails than the one used in this explanation, so determine which
type will best mount the magnets in your oven. Modifications to the clips may be
necessary to properly mount magnets.
“ELECTROVERT” CLIP
MAGNET

MAGNET

“P” CLIP

Figure 2-1: Magnet Clips

2. Open the top of the oven and determine where to place the Zone boundaries. The
minimum distance between zones must be no less than 4”.
3. Adjust the conveyor to match the OvenRIDER NL width. (The width of the pallet is
engraved on the back edge of the pallet top.)
4. Slide the OvenRIDER NL on the conveyor until the front sensor reaches the first predetermined zone boundary.
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5. Center a magnet and clip on the first zone boundary within .5” to 1.0” (1.3-2.5cm)
from the edge of the pallet and slide it past the magnet.

ZONE
SENSOR
LED

MAGNET &
“ELECTROVERT
CLIP

CONVEYOR
RAIL
MAGNET &
“P” CLIP
CONVEYOR RAIL

Figure 2-2: Magnet Alignment
• When the OvenRIDER NL front and rear zone sensors pass the magnet, the

zone sensor LED located on the top of the barrier box must illuminate and stay
illuminated for .75” +/- .25” (1.9cm +/- .6cm) while each sensor has moved
past it. Use the measuring scale on the edge of the pallet for a reference.
• When the OvenRIDER NL passes the magnet, the Sensor LED must not

double flash. If this occurs the magnet is placed to close to the pallet sensor.
The zone boundary magnets can cause the conveyor chain to become
magnitized. To prevent magnization, the North end of each magnet is marked for
easy identification so the magnent polarization can be alternated zone to zone.

OvenRIDER® NL
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6. When the magnet is properly aligned mount the “P” clip securely by tapping and
drilling for a #6 or 8 screw. If the “ELECTROVERT” clip is being used, simply clip it
to the rail and slide it into the desired position. Repeat for all zones making sure to
alternate each magnet end as you install them. (i.e.; north facing north and south
facing south)
Periodically check the magnet installation to be sure they are clean and that
nothing has attached to them. Objects attached to the magnets may disturb
components on the PCB while being soldered.
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2.2 Software Installation
Before the software is installed, view the README file on the software CD (any
standard text viewer can be used). The README contains the latest software
information and installation instructions.
Installing OR SPC:
All running applications must be closed before installing the software.
1. Insert the CD in the drive.
2. Select Run from the Start menu.
3. Type the drive name, colon, backslash and Setup in the Open text box and click
the OK command button.
For example, if CD ROM drive is the “D” drive type: D:\Setup.

Figure 2-3: Run Dialog Box

4. Closely follow the setup instructions provided with the software.

OvenRIDER® NL
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2.3 Communication Setup
After the interface cable is connected to a computer and M.O.L.E., the Communication
(COM) port must be configured in the software to match the same COM port as the
oven computer so they can communicate.
If no Serial port exists, use the included USB adaptor to connect the interface
cable to the computer.
To configure the COM port:
1. Start the software program by either double-clicking the OR SPC icon or
selecting it from the program sub-menu.

Figure 2-4: Program Icon

2. Once the software is running, select the Admin worksheet tab.

Figure 2-5:
Admin
Worksheet TAB
ADMIN
WORKSHEET
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3. Select the Configuration command from the File menu on the Admin worksheet
and the Configuration dialog box appears.

CONFIGURATION
COMMAND

Figure 2-6: Configuration Command

4. Click the Auto command button to have the software automatically find the COM
port the M.O.L.E. is connected. If the M.O.L.E. is not detected, there is a
communication problem (Refer to section 7.0 Service and Troubleshooting for
help).

Figure 2-7: Port Configuration Dialog Box

5. Click the OK command button to finish.

OvenRIDER® NL
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3.0 Operation
This section guides an operator of any work experience level through a typical data
collection process.
This section explains basic operation; please refer to the appropriate software
sections for detailed information.
• Step 1 - Data Collection Setup
After the hardware is setup and the software is installed, use the following steps to
collect data. Prior to collection data, the M.O.L.E. should be configured for your process.
To configure the M.O.L.E.:
1. Connect the M.O.L.E. to the PC.
2. Select the Configuration Wizard command from the OvenRIDER menu and the
Configuration dialog box appears.

Figure 3-1: Configuration

3. Click the option button next to a COM port which the PC is set up for RS-232
communications or the Auto command button to have the software automatically
find the COM port the M.O.L.E. is connected.
4. Click the OK command button to use the selection and continue to the
OvenRIDER Settings dialog box.
The user can exit the Configuration Wizard any time by selecting the Cancel
button.
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5. Type a company, operator, or machine name in the text box.

Figure 3-2:M.O.L.E. Settings

6. Click the OK command button to store the information in the M.O.L.E. and
continue to the Set Instruments Clock dialog box.
7. Enter the correct month, day, year, hour, minute, and second by adjusting the
slider(s) or manually typing in the corresponding text box.

Figure 3-3: Set Instrument Clock

When the Set Instrument Clock dialog box appears the current computer clock
setting is automatically entered in the text boxes.
8. Click the OK button to reset the clock.

OvenRIDER® NL
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• Step 2 - Data Collection
1. To start collecting data with the OvenRIDER NL, set the width of the conveyor to
match the width of the OvenRIDER NL. (The width is engraved on the back of
the pallet).
2. Set the oven as you normally would for a common product (i.e. zone
temperatures and conveyor speed etc…).
3. Open the barrier box and make sure the configuration plug is in place and the
M.O.L.E. is connected to the Connector Bridge.
4. Press the start/stop button once to start the M.O.L.E.. When the M.O.L.E. turns
“ON” the activity light will flash and then illuminate and stay constant for the
duration of the run.

Figure 3-4: OvenRIDER NL Preparation

5. Close the lid and latch securely.
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Never permit the M.O.L.E. to exceed the absolute maximum warranteed internal
temperature, as permanent damage may result. The warranty will not cover
damage caused by exceeding the maximum specified internal temperature.
6. Place the OvenRIDER NL on the oven conveyor making sure it is lying
completely flat and is moving in the proper direction. (There are direction arrows
on the top of the OvenRIDER NL barrier box that indicates the proper loading
direction.)

CONVEYOR

DIRECTION
ARROWS

Figure 3-5: Proper OvenRIDER NL Loading
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It is highly recommended that protective gloves are used when retrieving the
OvenRIDER from the oven and when opening the Thermal barrier.
7. Once the OvenRIDER NL has traveled completely through the oven, it will be
HOT. Use protective gloves to retrieve it from the oven. The best way to handle
the OvenRIDER NL after it comes out of the reflow oven is to place one hand
under the OvenRIDER NL pallet and use the other hand to grab the barrier
cover.
8. Open the OvenRIDER NL thermal barrier and if the Activity LED is still flashing
this means the M.O.L.E. is still logging and it must be turned “OFF”. To turn the
M.O.L.E. “OFF” press and Hold the Start/Stop button until the Activity LED turns
off, and then release the button.
When turning the M.O.L.E. “OFF”, do not release the button until the light goes
off. Pressing the Start/Stop button briefly will restart the data collection process
and erase all the data in memory.
9. Remove the M.O.L.E. from the OvenRIDER NL and wait a few minutes for the
M.O.L.E. to cool. Handle it carefully, as the case may still be warm.
When removing the M.O.L.E., be careful not to accidentally press the start/stop
button, this will restart the data collection process and erase any data in memory.
Data Collection Tips:
•

The OvenRIDER NL must be at approximately the same temperature at the start
of every run for the data to be consistent. Prior to data collection allow the
process sensors to either cool down or warm up to room temperature. This will
ensure that the data collected will start from a nominal temperature.

•

Let the OvenRIDER NL and/or M.O.L.E. cool down after every data run.
Performing multiple runs without sufficient cooling time may cause the internal
temperature of the M.O.L.E. to exceed the operating temperature specification.
(See Appendix A: Specifications for operating temperature specifications.)

•

If the M.O.L.E. is removed from the OvenRIDER NL before it has been turned
“OFF”, the data might become distorted
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• Step 3 - Data Transfer
When data is transferred from the M.O.L.E. to the PC, it is uploaded and saved in a
software Workbook file for analysis and report style printing.
To Read M.O.L.E. Data:
1. Restore the Software.
2. Select a desired Workbook file to upload the collected data.
3. Connect the M.O.L.E. to the PC using the PC interface cable.

Figure 3-6: Transferring Data
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4. Select the Read OvenRIDER Data command from the OvenRIDER menu and a
status bar dialog box appears indicating that data retrieval from the M.O.L.E. has
begun.

Figure 3-7: Read OvenRIDER Dialog Box

Once data transfer is complete, the dialog box will disappear and will return to
the current worksheet.
If the OvenRIDER detects less than 2 Zone Magnets, the software will inform the
user and prompt them to decide if they wish to use oven model data from the
AutoM.O.L.E. mailbox, or the previous profile.
5. Analyze the uploaded data.
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4.0 OR SPC Software
This section presents an overview of an OR SPC workbook management window.
When the software is started, it will automatically load the previously saved workbook
file.
The first time the software is started a sample file (i.e. ORSample.mor) will be
opened for users to familiarize themselves with the program. It is recommended
when the user starts collecting process data, a new or exiting workbook should
be used.
4.1 OR SPC Workbook Features
The workbook has several features as described in the following section.
TITLE BAR
MENUS
TOOLBAR

VERTICAL SCROLL BAR

WORKSHEET TAB
SCROLL ARROWS

STATUS BAR

SPLIT BAR

HORIZONTAL
SCROLL BAR

WORKSHEET TABS
Figure 4-6: Workbook Features
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•

Title Bar: This bar contains the program name, version, and the active workbook
file name.

•

Menus: These menus contain the commands and tools for each worksheet.
Each worksheet may contain different commands that supply specific support for
each worksheet. Individual worksheet menus are described in detail in their
specified sections of this manual.

•

Toolbar: The Toolbar has buttons to serve as shortcuts to the menu commands.
Individual worksheet toolbar buttons are described in detail in their specified
sections of this manual. Each worksheet may have different items on the toolbar
because of the different features offered by each worksheet.

•

Worksheet Tabs: These tabs are used to gain access to each worksheet.

•

Tab Scroll Arrows: These arrows are used to view other worksheet tabs if the
Horizontal scroll bar is covering them.

•

Split-bar: This bar slides the Horizontal Scroll bar to the left or right so all or part
of the worksheet tabs can be viewed.

•

Status Bar: This bar on the bottom of the worksheet display, shows the available
Help information, mouse pointer X-Y position, current date and time.

•

Horizontal Scroll Bar: This bar scrolls the worksheet display horizontally left
and right.

•

Vertical Scroll Bar: This bar scrolls the worksheet display vertically up and
down.
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4.2 Standard Worksheet functions
4.2.1 Worksheet tabs
There are six standard worksheets and up to nine optional SPC worksheets. Each
worksheet is labeled with worksheet tabs located on the bottom left of the screen.

Figure 4-7: Worksheet Tabs

4.2.2 Selecting Worksheets
To a view worksheet, use the mouse pointer to click on a worksheet tab. The worksheet
tab will then become highlighted, and the worksheet will now be visible.
The keyboard does not allow access to the worksheets. The only way to select
the worksheet is by using the mouse.

Figure 4-8: Selecting a Worksheet

4.2.3 Split-bar
The Split-bar on the tab bar lets the user slide the Horizontal scroll bar to the left or
right, so all of the worksheet tabs can be viewed. This feature is located on the left edge
of the Horizontal scroll bar.
4.2.4 Worksheet Tab Scroll Arrows
Worksheet tabs may be hidden behind the horizontal scroll bar. To view them the user
can either use the Tab Scroll Arrows located on the left of the worksheet tabs or use the
Split-bar.
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4.2.5 Scrollbars
The worksheets have both Horizontal and Vertical screen scroll bars so the non-visible
areas of the worksheet can be scrolled into view. The Horizontal scroll bar is located in
the lower right corner and can be scrolled left or right by pressing the left or right arrows
located on each end of the scroll bar. The user may also scroll the display by sliding the
center scroll bar left or right. The Vertical scroll bar located on the right side of the
screen has the same features as the Horizontal scrollbar except it scrolls the worksheet
display up and down.

CLICK HERE TO SCROLL WORKSHEET TABS
CLICK AND DRAG TO VIEW
WORKSHEET TABS

CLICK TO
SINGLE STEP
WORKSHEET
VIEW LEFT OR
RIGHT

CLICK AND DRAG TO SLIDE
THE VIEW HORIZONTALLY
Figure 4-9: Worksheet Options

It is recommended that the minimum PC display area be set to 800 x 600. For best
performance set the display to 1024 X 768 (Refer to your Microsoft® Windows®
documentation for details).
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5.0 Worksheet Descriptions
The following sections offer brief explanations for the worksheet functions, and how they
benefit the user. Refer to section 6.0 Menu and Tool Commands for information on the
menu commands.
5.1 Welcome Worksheet
The Welcome worksheet is the introductory worksheet. This worksheet contains a
OvenRIDER introductory illustration and a text box for entering a company or workbook
name.
Welcome worksheet features:
• Menus and Toolbar
• Company Name Text Box
MENUS
TOOLBAR

COMPANY NAME TEXT BOX

Figure 5-8: Welcome Worksheet
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5.1.1 Welcome Worksheet Menus and Toolbar
• Menus: File, View, OvenRIDER, Navigate, and Help.
• Toolbar Buttons: Print, Zoom In, Zoom Out, 100%, Read OvenRIDER Data, and
About.

Figure 5-9: Welcome Worksheet Menus and Toolbar Buttons
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5.1.2 Company Name
The text box located on the bottom half of the Welcome worksheet allows the user enter
a company or report name.
To enter a name:
1. Using the mouse pointer, click in the text box.
2. Type a desired name and then hit the [enter] key to accept or [esc] to cancel.

Figure 5-10: Entering a Company Name
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5.2 OvenRIDER Data Worksheet
The OvenRIDER Data worksheet is where summary information for the selected data
set is displayed in summary format. This worksheet contains information about the
overall Ambient and Process sensor data, M.O.L.E. status and individual zone data.
OvenRIDER Data worksheet features:
• Menus and Toolbar
•

Data sheet

MENUS
TOOLBAR
DATA SHEET

Figure 5-11: OvenRIDER Data Worksheet
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5.2.1 OvenRIDER Data Worksheet Menus and Toolbar Buttons
•

Menus: File, View, OvenRIDER, Navigate, and Help.

•

Toolbar buttons: Print, Zoom In, Zoom Out, 100%, Read OvenRIDER Data,
About, First (data run of the data set), Back (to previous data run), Forward (to
the next data run), and Last (data run of the data set).

Figure 5-12: OvenRIDER Data Worksheet Menus and Toolbar Buttons
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5.2.2 Interpreting the OvenRIDER Data Sheet
The following section defines the features of the OvenRIDER Data sheet. The Group
Parameters on the data sheet are color coded so when they are viewed on other
worksheets they can be easily associated with the Label Parameters.
(1)
(3)

(2)

(4)

Figure 5-13: Document View

(1)
(2)
(3)
(4)

Company Name, Machine Name and Part Number (configured by user).
Oven Summary data.
M.O.L.E. Status.
Individual Zone Data

See Appendix C: Measurement Definitions for Parameter defintions
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5.2.3 Data Coloring and LSL / USL
The parameter data and the user specified LSL (Lower Specification Limit) and USL
(Upper Specification Limit) text fields on the Admin (Administration) worksheet are
linked to indicate that a parameter has exceeded a user specified specification limit. If a
USL has been exceeded, that parameter will be underlined and appear on the Data
sheet in Red (indicating it is above the specification limit). If a parameter is less than the
user specified LSL, that parameter will be underlined and appear in the Data sheet in
Blue (indicating below the specification limit).

EXCEEDED USL
PARAMETER (RED)
EXCEEDED LSL
PARAMETER (BLUE)

Figure 5-14: Data Coloring

Refer to section 5.5.4 Specification and Control Limit Cells for information on how
to enter user LSL and USL values.
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5.3 Spreadsheet Worksheet
The Spreadsheet worksheet contains data that is collected by the OvenRIDER, and is
put into standard spreadsheet format. Each row in the spreadsheet represents one data
run. Using the Admin worksheet in conjunction with the Spreadsheet worksheet the user
can select parameters to be displayed on the worksheet.
Spreadsheet Worksheet features:
•

Menus and Toolbar

• Selected Data Run

•

Parameter Groups (color coded)

• User Definable Columns

•

Parameter Labels

• Parameter Units

•

Data Run Rows

• Filters
PARAMETER
LABELS

PARAMETER
UNITS

FILTERS

MENUS
TOOLBAR
PARAMETER
GROUPS

DATA RUN
ROWS

SELECTED
DATA RUN

USER DEFINABLE
COLUMNS
Figure 5-15: Spreadsheet Worksheet
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5.3.1 Spreadsheet Menus and Toolbar Buttons
•

Menus: File, Edit, View, Format, Window, OvenRIDER, and Help.

•

Toolbar buttons: New, Open, Save Workbook, Print, Undo, Redo, Zoom In, Zoom
Out, 100%, Align left, Center, Align right, Bold, Italic, Underline, Read
OvenRIDER Data, OvenRIDER Settings, and About.

Figure 5-16: Spreadsheet Worksheet Menus and Toolbar Buttons
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5.3.2 Parameter Group Row
Parameter Groups are the headers for a specific group of data parameters collected by
the M.O.L.E.. They are color coded with the associated Parameter Labels so they can
be easily identified together.
The width of each parameter column can be adjusted to be larger or smaller by
placing the mouse pointer over a split line dividing the parameter columns and
sliding it to the desired width.
PARAMETER GROUP

SPLIT-LINE POINTER.

Figure 5-17: Parameter Group
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The Parameter Groups are defined as the following:
User Defined Parameter Group:
These parameter columns can be used to
enter text to help identify the row with unique
information about that run (i.e. shift, operator,
line number, part number). This information will
also appear in the Tool Status box on the
Profile worksheet.
General Parameter Group:

This group contains file information associated
with the run such as; date and time, (of profile)
and the data file tag.

M.O.L.E. Parameter Group:

This group contains the physical condition of
the M.O.L.E. at the end of the run.

Oven Parameter Group:

This group contains the overall oven data such
as the Process and Ambient sensors,
throughout the entire process.

Zone Parameter Group(s)

These group(s) give the user detailed
information about of the Process and Ambient
sensors for each specific zone in the oven.

OvenRIDER® NL
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5.3.3 Parameter Labels
The Parameter Labels are where all of the specific parameters for each group are listed.
The user can decide which parameters will be shown on the Spreadsheet worksheet
from the Admin worksheet as discussed in section 5.5.3 Spreadsheet Parameters View
check boxes.

PARAMETER LABEL

Figure 5-18: Parameter Label

5.3.4 Parameter Units
The Parameter Units are the units of measurement for that parameter column. For
example, in the Oven Ambient Parameter Group the Parameter Label Start Temp is in
°C.

PARAMETER UNITS

Figure 5-19: Parameter Units
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5.3.5 Data Run Rows
All of the data runs uploaded into a workbook file are listed on the Spreadsheet
worksheet as individual rows. The first data run uploaded into the workbook file is on the
bottom and the most recent data run uploaded is on the top.
When any data run row is selected, all of the cells in the entire row are highlighted in
purple and blue. The purple cells indicate that the cells can be modified and the blue
cells indicate the data cannot be modified.
When any individual data cell in a data run row is selected, all of the cells in the entire
row are highlighted in green and yellow. The green cells indicate that the cells can be
modified and the yellow cells indicate the data cannot be modified.
The data run rows can also be moved into any order desired. This is useful when the
user wants to place similar data runs together.
To change the order of the data run:
1. Select the number cell of a data run row with the mouse pointer. The row will
then become highlighted in purple and blue.
5. Drag the row and drop it to a desired location.

Figure 5-20: Drag and Drop Data Rows

5.3.6 Selected Run
When a data run row is selected, the data for that row will be shown in the Sel= row
located at the bottom of the data run rows. This row also allows the user to easily
compare the selected data row to the statistics calculations located below the selected
run row.
Entire selected rows and columns can be “copied” by pressing keys (CTRL + C)
and then “pasted” (Ctrl + V) into other spreadsheet applications.
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5.3.7 Filters
There are Filters for each parameter label that filter specific data out of runs listing.
Filtering more than one column at a time acts as a Logical AND Function. All
conditions of all set filters must be met for data row(s) to remain visible.
How to use the Filter function:
1. Click the Filter button to reveal the unique data as populated in that column
under that particular parameter label.
2. Select a desired data value to filter, or the two standard filters All and Special.
FILTER ARROW BUTTON

Figure 5-21: Filter Function
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To use the All option:
1. Select All to reset the filter for that column and view all of the data run rows that
meet the other column filters.
To use the Special option:
1. Select Special to select data run rows within a range of values. There are multiple
options to select information to filter by clicking the appropriate relational
operators option button (See Figure 5-22). The user can either select data from a
populated list or type it in the text box on the top of the column.
=
>
<

equal to
greater than
less than

>= greater than or equal to
<= less than or equal to
<> Not equal to

Figure 5-22: Relational Operators
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2. Select a data filter by:
•

Clicking the greater than relational operator option button beside the left data
column.

•

Click a parameter value from the list or type it in the text box.

•

Click the AND logical operator option button.

•

Click the less than relational operator option button beside the right data column.

•

Click a parameter value from the list or type it in the text box.

The Clear command button can be selected at any time to clear the selections and
the new values can be selected.
3. Click the OK command button to accept the selected data filters or Cancel to
return to the worksheet without executing the filter request.

Figure 5-23: Special Filter Feature Dialog Box

In this example, the data filtered would be all times between, but not including 06:25:33
and 14:08:00.
To reset all of the data set rows to restore the entire set of collected data, click
the Filter Reset button on the Spreadsheet worksheet.
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5.3.8 Statistics
There are rows located on the bottom of the Spreadsheet worksheet, which are the
combined calculations for all the data runs that are currently being viewed in the
Spreadsheet worksheet display. The following information is the definitions for each
Statistics row:
• N = Number of samples included in the calculations
•

Min. = The lowest value in the parameter column.

•

Max. = The highest value the parameter column.

•

Avg = The average of all values in the parameter column.

•

Std. Dev. = The standard deviation of the values in that column.
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5.4 Profile Worksheet
The Profile worksheet is where oven process and ambient data is represented
graphically. The software allows the user to analyze the data and to compute statistics
based on the data.
Profile worksheet features:
• Menus and Toolbar

y Status Bar

• M.O.L.E. Status

y Data Tabs

• Tool Status

y Data Table

• Magnify Map

y Scale

• Sensor Locations

y Data Graph

• Channel Check Boxes
MENUS &
TOOLBAR

DATA GRAPH

M.O.L.E.
STATUS

TOOL STATUS
BOX

MAGNIFY MAP
SENSOR
LOCATIONS
CHANNEL
CHECK
BOXES
STATISTICS
TABS
DATA TABLE

STATUS BAR

Figure 5-24: Profile Worksheet
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5.4.1 Profile Menus and Toolbar Buttons
•

Menus: File, Window, OvenRIDER, Profile, Tools, Manual Zones, Navigate, and
Help.

•

Toolbar buttons: New, Open, Save Workbook, Print, Magnify, Slope, Peak
Difference, Overlay, 3-D, Notes, Erase Object(s), Erase All, Read OvenRIDER
Data, OvenRIDER Settings, About, First (data run of the data set), Back (to
previous data run), Forward (to the next data run), and Last (data run of the data
set).

Figure 5-25: Profile Worksheet Menus and Toolbar Buttons
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5.4.2 M.O.L.E. Status
The M.O.L.E. STATUS box contains information about the status of the M.O.L.E. while it
collected the data the selected run.

Figure 5-26: M.O.L.E. Status Window

•

Max Internal T: This is the highest internal temperature logged during the
displayed profile and is displayed in degrees Celsius. If the highest temperature
logged is in the specified internal operating temperature range of is 0-54°C, it
appears in BLACK. When the internal temperature is 55-64°C, it appears in
YELLOW indicating that the M.O.L.E. has reached the Warning zone and is
approaching the maximum recommended operating temperature of 65°C. If the
internal operating temperature is above 65°C, it appears in RED indicating that
the maximum internal operating range has been reached.

•

Battery: The battery voltage measured during the upload of that run. The nominal
range for normal operation is 5.1 to 4.7V.

•

Points: The number of data samples recorded at the configured interval.

•

Active: Indicates which channels were active during the experiment. A number
means an active channel; a “O” is an inactive channel. An "X" means an open or
out of range T/C was detected on that channel during the data run.

•

Interval: Time between data shown in hours, minutes, seconds, and tenths of
seconds data points: hh:mm:ss.t.

•

Date: Date of last data point logged.

•

Time: Time of last data point logged.

•

V: Firmware Version displays the operating code of the M.O.L.E. (This is where
customer service will ask you to find the version number for the M.O.L.E.)
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5.4.3 Tool Status
The Tool Status box displays information on how to use a selected tool command and
other information during tool use. Prior to using a tool command, the Tool Status box
displays the Spreadsheet worksheet User definable column information that is
associated with the selected data run.

Figure 5-27: Tool Status Box

When a Tool command such as Magnify is selected, a message appears in the box
stating “Click and drag to select area”.

Figure 5-28: Tool Status Message

5.4.4 Magnify Map
The Magnify Map displays a small map of the entire profile and indicates the area
currently magnified with a red crosshatched box.
MAGNIFIED
AREA

Figure 5-29: Magnify Map
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5.4.5 The Data Table
The Data Table includes various values depending on which Data Tab is selected. The
rows always indicate the channel and the columns vary depending on which data tab is
active.

DATA TABLE
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Figure 5-30: Data Table
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5.4.5.1 Value Pop-up
Each value in the Data Table can be displayed as a Value Pop-up. A Value Pop-up is
graphically illustrated on the Data Graph showing how and where that value was
extracted from the profile.
Only one Value Pop-up can be displayed on the Data Graph at a time.
VALUE POP-UP

SELECTED VALUE
Figure 5-31: Value Pop-up

To display a Value Pop-up:
1. Select the Profile worksheet.
2. Move the mouse cursor and pause over a desired value in the Data Table. That
value will automatically be displayed on the Data Graph where that value was
extracted.
The last displayed Value Pop-up will remain on the Data Graph until the user
selects a different worksheet.
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5.4.5.2 Show/Hide Columns
Data Table parameter columns on the Profile worksheet can be hidden. This is useful
when an operator wants to focus attention to the most important parameter columns.

Figure 5-32: Show/Hide Columns

To display Show/Hide columns:
1. Select the Profile worksheet.
2. Right click a parameter column header.
3. Clear a parameter check box to hide or select to display.
Hidden Parameter columns do not affect the data being collected for that
parameter. If all Parameter columns are hidden, right-click the Sensor locations
column header to open the Show/Hide column dialog box.
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5.4.5.3 Change Summary Stats Settings
When creating a new workbook, a dialog box appears allowing the user to specify
Summary Statistics settings based on a Paste Specification or the user selected values.
If the process changes or an operator wishes to perform test experiments, these
settings can be changed by clicking a parameter column header on the Profile
worksheet.

Figure 5-33: Modify Summary Stat Settings

To Change Summary Stats Settings:
1. Select the Profile worksheet.
2. Select the Summary Stats tab.
3. Click the Time Above or Time between column header.
4. Change the desired Summary Stats settings and select the OK command to
accept.
5. Once the new settings have been accepted, the software prompts the user to
decide if these new settings should be applied to future data run profiles.
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5.4.5.4 Change Slope Calculator
Positive and negative slope profile parameter calculator allows the user to calculate
straight line slopes between any two temperatures. (Default to liquidous and liquidous to
peak).
If the process changes or an operator wishes to perform test experiments, these
settings can be changed by clicking a parameter column header on the Profile
worksheet.

Figure 5-34: Modify Summary Stat Settings

To Change Slope Calculator:
1. Select the Profile worksheet.
2. Select the Summary Stats tab.
3. Click a Peak Slope column header.
4. Change the desired settings and select the OK command to accept.
5. Once the new settings have been accepted, the software prompts the user to
decide if these new settings should be applied to future data run profiles.
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5.4.6 Sensor Locations
The location for each sensor labeled in the Data Table. The color and description
indicates which Data Plot on the Data Graph it designates. The top three sensor
location descriptions are the Ambient sensor temperatures, and the bottom three are
the Process Delta numbers.

SENSOR LOCATIONS

Figure 5-35: Sensor Descriptions

5.4.7 Channel Check Boxes
The Channel check boxes control whether the associated Data Plot is displayed on the
Data Graph and whether the data for that channel are included in the data table. To
view or remove a Data Plot, click the channel check box beside a sensor location
description to turn it “ON” or “OFF”.

CHANNEL CHECK BOXES

Figure 5-36: Channel Check Boxes
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5.4.8 Status Bar
The Status Bar displays the available Help information, X-Y positions of the mouse
pointer, current date and time.

HELP INFORMATION

X-Y READOUT

DATE & TIME

Figure 5-37: Status Bar Features

• Help Information
When the mouse pointer is placed over a Toolbar button the left side of the Status bar
will display the action that button performs.
• X/Y Readout
It is easy to find the exact X and Y-values of any point on the Data Graph using the
mouse pointer. The X/Y Readout continuously displays the X and Y-axes values of the
mouse pointer location.
The units displayed for X and Y-values are the same as those displayed on the graph.
The user can select between °F and °C for the Y-value units. The X-value units can be
a data point number, time, or distance. Units can be changed on the X and Y-axes at
any time by selecting the Units command in the Profile menu.
While using the Magnify tool, the X/Y Readout displays the size of the selected
area of interest.

Other ways to view exact X- and Y-coordinates of a data point is to select the
Value Tab.
y Date and Time
This area of the Status bar displays the current time and date of the PC.
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5.4.9 Data Tabs
Data Tabs is where the user can view a variety of sensor information in the Data Table.
The Data Tabs are:
•

Value

•

Time to Ref

•

T above Ref

•

Statistics

•

Summary Statistics

• KPI (Key Process Indicators)
Only one data tab can be active at a time. Each is described below.
When the Magnify tool is used to zoom in on a portion of the Data Graph, the Data
Table displays the statistics for those values that are displayed. (This feature
does not apply to the Summary Stats Data Tab).
5.4.9.1 Value
When the Value Tab is selected, the Data Table lists the temperature at the point where
an X-cursor intersects a Data Plot. There are four X-cursors and the positions can be
changed at any time by moving the X-cursor (Refer to the descriptions in section
5.4.10.5 X-Cursors). As an X-cursor is moved, the values in the Data Table are
automatically updated.

Figure 5-38: Value Data Tab

Values in the Data Table depend on the units of the X and Y-axis.
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5.4.9.2 Time to Reference
When the Time to Reference Tab is selected, the Data Table displays the time it takes
the channels to reach fixed Temperature Reference Line(s). Times are expressed as
HH:MM:SS (H=hours, M=minutes, S=seconds). Up to three Temperature Reference
Lines can be added to the Data Graph that are used in this statistic by using the Temp
Ref Lines command in the Profile menu.

Figure 5-39: Time to Ref Data Tab

5.4.9.3 T Above Ref
When the T Above Ref Tab is selected, the Data Table shows the amount of time each
sensor measured data above the Temperature Reference Lines. Times are expressed
as HH:MM:SS (H=hours, M=minutes, S=seconds) and are the total time above
reference line regardless of when the value was above.

Figure 5-40: T Above Ref Data Tab

Temperature Reference Lines can be added, deleted, or moved at any time using
the Temp Ref Lines command in the Profile menu.

♦52♦

OvenRIDER® NL

The last column labeled Cure Factor%. The cure factor % is based on the time a sensor
temperature was above a temperature reference line divided by the time you entered in
the Times Above Temp (TAT) section of the Temp Ref Lines dialog box. This equation
gets more complicated as you add more temperature reference lines. The graph
illustrates the times used (shaded area) to sum the total curing time each temperature
threshold contributes.
LO
MED
HI
HIre
MEDre
LOr

The following equation is used when all three temperature reference lines are used:
Cure Factor % = 100 * ( HItime/HItat + (MEDtime – HItime) /MEDtat + (LOtime – MEDtime)/LOtat )

The same basic equation is used when there are only two (any two) temperature
reference lines used:
Cure Factor % = 100 * ( HItime/HItat + (MEDtime – HItime) /MEDtat )

or
Cure Factor % = 100 * ( MEDtime/MEDtat + (LOtime – MEDtime) /LOtat )

or
Cure Factor % = 100 * ( HItime/HItat + (LOtime – HItime) /LOtat )

Finally, if only one temperature reference line is used, the equation is simply:
Cure Factor % = 100 * time/tat (which ever temp ref line you are using)\
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5.4.9.4 Statistics
When the Statistics Tab is selected, the first four columns of the Data Table displays the
minimum and maximum temperature found for each Data Plot and the value of X (time,
distance, or point number) at which it occurred.
The last two columns of the Data Table displays the Average (Mean) and Standard
Deviation of the temperature values recorded for each sensor.

Figure 5-41: Statistics Data Tab

If a portion of the Data Graph is magnified using the Magnify tool, the Data Table
displays the Mean and Standard Deviation of the values currently displayed.
5.4.9.5 Summary Statistics
When the Summary Stats Tab is selected, the Data Table displays a summary of primary
statistics from the entire data set. These summary statistics always display the statistics
derived from the entire profile regardless of the level the Data Graph is zoomed.

Figure 5-42: Summary Statistics

5.4.9.6 KPI (Key Process Indicators)
When KPI is the active data tab, the Data Table displays statistics from the Profile
configured by the user. This is useful so the user can display the most important
information that best suits their needs or application.

Figure 5-43: KPI Data Tab
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Key Process Indicators Setup:
1) Make sure the KPI Data Tab is active.
2) Click the KPI Setup button above the Sensor Locations descriptions.
The KPI Setup can also be activated by right-clicking a column header.

Figure 5-44: KPI Setup

3) Click the desired parameters to display in the Data Table. The parameters are
grouped by Temperature, Cursor data with slope between, and Time. The user
can also select to display Range, Average and Standard Deviation rows for each
of the columns.
4) When finished select the OK button to display the new settings or Cancel to return
to the worksheet without making any changes.
A maximum of 12-16 parameter columns can be displayed at one time. As
columns populate the Data Table, they are automatically sized to fit. It is
recommended that the most beneficial column information is displayed to
achieve the best results.
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5.4.10 The Data Graph
The Data Graph is a display that shows the data collected from the data run overlaid on
a graph. The user can analyze and highlight various process features with the tools
listed below.
• X and Y-Axes and Labels
•

Autoscaling

•

Data Plots

•

Process Origin

•

X-Cursors

•

X-axis Units

• Temperature Reference Lines
The Data Graph features are described in the sections that follow. Some of these
features described are also controlled using the appropriate menu options. Refer to
section 6.0 Menu and Tool Commands for more information.
5.4.10.1 X and Y-Axes and Labels
The Y-axis (vertical) displays the scale of the measured temperature. Lower values are
at the bottom and higher values at the top.
The Y-axis includes temperature labels on the left side of the graph. These four
temperatures divide the vertical axis into four equal parts and are automatically scaled
to fit the current Y-axis limits. These units can be displayed in Celsius or Fahrenheit
using the Units command in the Preferences sub-menu on the Admin worksheet.
The X-axis (horizontal) displays values data points collected. The X-axis can be
converted from data points to time or distance using the Units command in the Profile
menu.
To see the X-value of any location on the Data Graph, the software provides three
different methods:
•

The X/Y Readout in the Status bar continuously displays both X and Y-values at
the location of the mouse pointer. Details of this feature are described in section
5.4.8 Status Bar.

•

The X-value at the position of each X-Cursor is displayed in the Data Table when
the Value statistic is active.
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5.4.10.2 Autoscaling
The software includes a powerful Autoscaling option to automatically scale the Data
Graph so the data will always be visible and easy to work with. The software will
automatically select a range of values for both the X and Y-axes to ensure that all the
data fits on the screen. The user can change the range of Y-values displayed in Manual
mode by entering a manual mode using the Scaling command in the Profile menu.
Another way to scale the graph’s X and Y-axes is to use the Magnify tool
described in section 6.8.1 Magnify Tool.
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5.4.10.3 Data Plots
The Data Plots in the Data Graph represent the data for each of the OvenRIDER NL
sensors. Each sensor is represented by a different color that corresponds to the color of
its sensor location description in the Data Table.

DATA PLOTS

Figure 5-45: Data Plots

A Data Plot in the Data Graph can be suppressed or restored at any time by clicking the
check box with the corresponding sensor description in the Data Table. This allows the
user to view any combination of the Data Plots or individually.
When two or more Data Plots overlap the same values, the Data Plots overwrite
each other. For example, if the Data Plot that represents the Ambient Sensor (A)
and Ambient Sensor (C) have the same value, the Ambient Sensor (A) Data Plot
will only appear unless the user suppresses it.
When printing a Data Graph in black and white, suppressing one or more Data Plots is
useful for clearing a view of a Data Plot that is obscured by others near it.
When printing the Data Graph in black and white, the Notes tool can be used to
help identify each Data Plot.
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Data Plots that show when the front and rear zone boundaries are detected can be
displayed in the Data Graph by clicking the Show Sensors box.

Figure 5-46: Zone Boundary Sensors
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5.4.10.4 Process Origin
The Process Origin is a gray vertical line at the left edge of the Data Graph to indicate
where the process starts. The Process Origin is automatically set by the software when
the data is uploaded from the M.O.L.E.. When Points or Distance units are being used
for the X-values, the X-values to the left of the Process Origin are displayed as negative
and those to the right as positive.

PROCESS
ORIGIN

Figure 5-47: Process Origin

To move the Process Origin:
1. Select the Process Origin line by positioning the mouse pointer anywhere on the
line.
2. Press and hold the left mouse button.
3. Move the line by dragging it left or right.
4. Release the mouse button when the Process Origin is at the desired location.
The X/Y Readout in the Status Bar indicates the true position of the Process Origin
while it is being moving. After the mouse button is released, the X-Readout changes to
zero at the Process Origin and displays negative numbers for X when the mouse pointer
is moved to the left of the Process Origin.
X-Cursor values are automatically adjusted when the Process Origin is moved.
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5.4.10.5 X-Cursors
The Data Graph has four X-cursors that indicate the temperature values at the
intersection of a Data Plot with each X-cursor. When the Value Data Tab is selected,
these values are displayed in the Data Table in four data columns labeled C1, C2, C3,
and C4, representing X-cursor 1 through X-cursor 4 respectively.

VALUE STATISTICS TAB

X-CURSORS

Figure 5-48: X-Cursors
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To move an X-cursor:
1. Select the Value Data Tab.
2. Position the mouse pointer over the X-cursor grip (the small triangle below a Xcursor) then press and hold the left mouse button and drag it left or right
releasing the mouse button when the X-cursor is at the desired location.
•

The user can also press the [tab] key to toggle select an X-cursor. When the
desired X-cursor is selected, the small triangle will turn red. Then pressing either
the left or right arrow keys will step the X-cursors. Each step is one pixel or one
degree which ever is larger. This feature achieves cursor positions that are more
precise.

Moving the selected cursor can be pushed into other cursors causing them to
move them ahead of it.
The position of an X-cursor controls the values displayed in the Data Table. When an Xcursor is moved, values in the Data Table are automatically updated.
The Data Table includes a row for each of the OvenRIDER sensors. The numbers in the
four columns indicate the Y-values at the intersection of a Data Plot with an X-cursor.
(Refer to section 5.4.9.1 Value)
When an X-cursor is dragged to a new position, it automatically snaps to the closest
real X-value. Notice on highly magnified graphs that the cursor jumps from point to
point. In an extreme case, if the graph is so highly magnified that there are no real Xvalues to move to, the X-cursors cannot be moved at all.
The Process Origin is the initial point from which all X-axis position data is
calculated. After releasing the Process Origin at the appropriate point on the
graph, X-cursor values are recalculated and displayed.
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5.4.10.6 X-axis Units
The user can select three different types of X scales for the X-axis. The scales are
Point, Time (time measure from process origin), and Distance. To change, select the
Units command in the Profile menu.
The scale is displayed only when a data tab other than Value is selected.

LOGGED
POINT
SCALE

TIME
RELATIVE

DISTANCE
SCALE

Figure 5-49: Scale Types

The Distance scale will not be accurate until an accurate conveyor speed is set.

OvenRIDER® NL

♦63♦

5.4.10.7 Temperature Reference Lines
Temperature Reference Lines are colored horizontal lines that are positioned within the
range of Y-values in the graph. Up to three Temperature reference lines can be added
to the Data Graph using the Temp Ref Lines command in the Profile menu.
Temperature Reference Lines are used in analysis when the T Above Ref (Time above
the Reference Line) statistic is active. (T Above Ref statistic is described in section
5.4.9.3 T Above Ref).
5.4.10.8 Zones and Zone Sizes
The X-axis can be divided into zones that represent oven zones in a process. As many
as thirty zones can be specified using the Zone Configure fields on the Oven Configure
dialog in the Manual Zones menu. Zones sizes are defined in units of length or time.
To view zones along the X-axis, click the Show Zones check box on the Oven Configure
dialog box. When zones are displayed, they appear as two colored lines along the
bottom of the data graph and as dotted vertical lines that extend top to bottom. The first
zone begins at the Process Origin. When the Process Origin is moved, the zones move
with it.
5.4.10.9 Zone Temperatures
For each zone, two zone temperatures can be established using the Zone Temps fields
on the Oven Configure dialog box. These temperatures might be upper and lower
boundaries for the acceptable range of values in that zone or they might represent the
settings of upper and lower heating elements in a process.
Zone Temperature Lines appear in the Data Graph as colored bars at the temperature
set for each zone. (Zone Temperatures can be displayed only after zone sizes are
defined).
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5.4.10.10 Zone Matrix
A Zone Matrix can be displayed above the Data Graph, when the check box on the
Oven Configure dialog box is selected. The white cells on the matrix will is where the
user can enter new value(s) for the Zone Length and the Top temperatures.
ZONE MATRIX

Figure 5-50: Zone Matrix

OvenRIDER® NL

♦65♦

5.5 Administration Worksheet
The Administration worksheet is where all of the M.O.L.E. parameters are controlled.
The parameters collected by the M.O.L.E. are in the Spreadsheet parameter column
located on the left side of the worksheet. Each parameter has a check box for viewing
(or not) on the Spreadsheet worksheet. The right side of the Admin worksheet contains
SPC sheet setup boxes, for defining the SPC charts. There is also an option to specify
LSL (Lower Specification Limits), USL (Upper Specification Limits), LCL (Lower Control
Limits), and UCL (Upper Control Limits) in the cells located to the right of each
parameter.
Admin Worksheet features:
• Menus and Toolbar buttons

• Spec and Control Limit Cells

•

Spreadsheet Parameters

• SPC Sub-Group Size

•

Parameter check boxes

• SPC Sheet Parameter Boxes

SPREADSHEET
PARAMETERS
MENUS &
TOOLBAR

SPEC LIMIT
CELLS

SPC SUB-GROUP SIZE
CONTROL LIMIT
CELLS

SPC SHEET
PARAMETER
BOXES

PARAMETER
CHECK
BOXES

Figure 5-51: Administration Worksheet
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5.5.1 Admin(istration) Menus and Toolbar Buttons
•

Menus: File, Edit, View, Format, Window, OvenRIDER, and Help.

•

Toolbar buttons: New, Open, Save Workbook, Print, Undo, Redo, Zoom In, Zoom
Out, 100%, Align left, Center, Align right, Bold, Italic, Underline, Read
OvenRIDER Data, OvenRIDER Settings, and About.

Figure 5-52: Admin Worksheet Menu Bar and Tool Buttons
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5.5.2 Spreadsheet Parameters
The Spreadsheet Parameters are arranged in a column that contains all of the
parameters that the M.O.L.E. collects during a data run. The parameters are arranged
by colors as described in section 5.3.2 Parameter Group Row. Each cell has the Group
Parameter listed first and the Label Parameter listed second.
Zone parameters increase as more zones are detected.

LABEL PARAMETERS

GROUP PARAMETERS

Figure 5-53: Spreadsheet Parameters Defined

5.5.3 Spreadsheet Parameters View check boxes
Each Spreadsheet Parameter on the Admin worksheet has a check box located on the
left. To display a parameter on the Spreadsheet worksheet, click the corresponding
check box. Similarly if you do not want to view the parameter, remove the check mark
by clicking the check box.
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5.5.4 Specification and Control Limit Cells
There are cells to the right of each parameter for specifying an LSL (lower specification
limit) and an USL (upper specification limit) for each parameter. The user can also
specify an LCL (upper control limit) and UCL (upper control limit) to be applied to a SPC
chart.
• LSL and USL Cells
These limits notify the user if the parameter is above or below the LSL or USL during a
data run. When a parameter is below the user specified LSL, it appears on the
OvenRIDER Data worksheet in blue and will be underlined. When a parameter is above
the user specified USL it appears on the OvenRIDER Data worksheet in red and will be
underlined.

USER
CONTROLLED
LSL & USL

LSL & USL CELLS

Figure 5-54: User Specified Specification Limits
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• User Controlled LSL and USL
The user can automatically set a LSL and USL for each parameter by using a drop
down list box that contains options to set the LSL to -3, -2, -1, standard deviation or –
10% and –5%. The USL can be set to +3, +2, +1 standard deviation or +10% and +5%.

Figure 5-55: User Controlled LSL and USL

The values calculated are taken from the current data viewed on the Spreadsheet
worksheet.
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• LCL and UCL Cells
Lower and Upper control limits are automatically calculated from the Spreadsheet
parameter data and displayed on the SPC control charts when an SPC worksheet is
created. The LCL and UCL cells allow the user to override the calculated limits and
manually set them.

USER
CONTROLLED
LCL & UCL

LCL & UCL CELLS

Figure 5-56: User Specified Control Limits

• User Controlled LCL and UCL
The user can automatically set a LCL and UCL for each parameter by using a drop
down list box that contains options to set the LCL to -3, -2, -1, standard deviation or –
10% and –5%. The UCL can be set to +3, +2, +1 standard deviation or +10% and +5%.

Figure 5-57: User Controlled LCL and UCL

The values calculated are taken from the current data viewed on the Spreadsheet
worksheet.
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5.5.5 SPC Sheet Boxes
The right side of the Admin worksheet contains nine SPC sheet boxes. These boxes are
used to create the SPC worksheets.

Figure 5-58: SPC Sheet Boxes

An SPC worksheet can be created by dragging and dropping a parameter or by using
the drop down list box.
To create a SPC Worksheet:
Drag and Drop:
1. Select a parameter and drag it from the Spreadsheet Parameter column and
drop it into a SPC Sheet cell. Up to three parameters per SPC Sheet can be
selected.
CHECK TO ACTIVATE
SPC WORKSHEET(S)

Figure 5-59: Drag and Drop Parameter

2. When finished, click the check box in the SPC Sheet Label to activate the SPC
sheet.
3. To view the SPC Sheet, click the new SPC worksheet tab (See section 5.7 SPC
Worksheet for more details).
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Parameter list:
1. All of the SPC sheet boxes have drop down list boxes located on the right side of
the parameter cell. To select a parameter click the drop down list box arrow
button and a list of parameter groups appears.

CHECK TO SELECT A
PARAMETER GROUP

Figure 5-60: Drop Down List Box

2. Select the group from the drop down list that includes the desired parameter. A
dialog box will then appear listing all of the parameters in that particular group.
3. Select the desired parameter from the list and click the OK command button.

Figure 5-61: Parameter Dialog Box

4. When finished, click the check box in the SPC Sheet Label to activate the sheet.
5. To view the SPC Sheet, click the new SPC worksheet tab (See section 5.7 SPC
Worksheet for more details).
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Replacing and Deleting SPC Parameters:
To change the parameters in the SPC Sheet boxes, drag and drop a different parameter
over of the existing parameter or repeat the drop down list method of selecting a
parameter.
To delete a parameter, click and drag the parameter off the SPC Sheet box to remove.

Figure 5-62: Erase Bar
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5.6 Guide Worksheet
The Guide worksheet is a quick reference guide to assist new and experienced users
through basic operation steps.

Figure 5-63: Guide Worksheet
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5.7 SPC Worksheet
The SPC worksheets display the assembled Spreadsheet parameters using the Admin
worksheet. Each SPC worksheet can display three X-bar and R charts and up to a
maximum of nine SPC worksheets can be created.
SPC worksheet features:
• Menus and Toolbar buttons
•

X-Bar Chart

•

R Chart

•

Statistics box

MENU &
TOOLSBAR

STATISTICS BOX

X-BAR CHART

R CHART

Figure 5-64: SPC Worksheet

♦76♦

OvenRIDER® NL

5.7.1 Menus & Toolbar
•

Menus: File, View, Window, OvenRIDER, and Help.

•

Toolbar buttons: Print, Zoom In, Zoom Out, 100%, Read OvenRIDER Data, and
About.

Figure 5-65: SPC Worksheet Menu Bar and Tool Buttons
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5.7.2 X-Bar Chart
The X-Bar Chart is the graphical chart produced from samples of a selected parameter.
The chart uses a rolling average of 2 through 6 sample points specified by the user. The
X-bar is the average of the data samples and the UCL and LCL are calculated using a
formula based on the Range data.

UCL & LCL

CALCULATIONS
NUMBER

X-BAR CHART

Figure 5-66: X-Bar Chart

The calculation numbers vary depending on the data in the Spreadsheet
worksheet. Using the filter function or the hide command allows the user to
select the specific data runs to include on the SPC chart.
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5.7.3 R Chart
The R Chart is the graphical chart produced from the selected parameter. The R-Bar is
the averages of the range samples.
If the Sub-Group size is set to 1, the R chart becomes a moving range (mR) chart.
The moving range is the difference between a specified X value and the one
preceding it.
R CHART

CALCULATION
NUMBER
UCL
R-BAR

Figure 5-67: R-Bar Chart

The calculation numbers vary depending on the data in the Spreadsheet
worksheet. Using the filter function or the hide command allows the user to
select the specific data runs to include on the SPC chart.
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5.7.4 Statistics Box
The Statistics Box reflects the current SPC data from the selected, sorted and filtered
data set parameter.
Statistics box data:
•

N = Number of subgroups.

•

Min. = The lowest data point on the graph.

•

Max. = The highest data point on the graph.

•

X-2 bar = The current X-Bar Bar calculation.

•

Std. Dev. = The Standard Deviation of the selected parameter.

•

Cp; CpK = Process capability indeces (Refer to Appendix B: Statistical Process
Control (SPC) Background Information for more information).

Figure 5-68: Statistics Box
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5.7.5 Renaming SPC Worksheets
The user has the ability to rename all of the SPC worksheet tabs to best reflect the
worksheet data.
To change a worksheet name:
1. Double-click the desired SPC worksheet tab and a pop-up text box appears
above the worksheet tab.

Figure 5-69: Pop-up Text Box

2. Type a new name in the pop-up text box and hit the [enter] key to accept or the
[esc] key to cancel.
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6.0 Menu and Tool Commands
This section explains how to use all of the Menu and Toolbar button commands. Each
of the following sections will list all of the commands specific to each of the menus.
The dimmed menu commands are used in other worksheets.
6.1 File Menu
Commands in the File menu are used to manipulate and configure workbook files.
6.1.1 New Workbook
Select the New Workbook command from the File menu to start a new workbook. A
message box appears requesting the user select a file folder directory to save the new
workbook.
After the file location has been determined, a dialog box appears allowing the user to
specify Summary Statistics settings for the workbook based on user selected values or
default values derived from a typical paste.

Figure 6-8: Summary Statistics Settings

When a new workbook is created, it uses these values as thresholds for the Summary
Statistics Data. A table of these values extracted from the profile can be viewed on the
Summary Stats tab.
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Workbook files are saved with a file extension of (.MOR), and the Profile data
from the Profile worksheet are saved with an extension of (.MDM). These two file
types will automatically be saved in the same file folder directory because they
are inter-dependent on each other and should not be seperated.

Figure 6-9: New List Box

The New Workbook command can be accessed on the Toolbars of the Spreadsheet,
Profile, Admin, and SPC worksheets. This command can also be used by pressing Ctrl
+ N.
• New Workbook Button:
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6.1.2 Open Workbook
The Open Workbook command enables the user to open existing workbook files.
To open a workbook file:
1. Select the Open Workbook command from the File menu. A list box of workbook
files with an extension of (.MOR) files appears.

Figure 6-10: Open List Box

2. Highlight the desired workbook file to open by clicking.
3. Click the Open command button to open, or Cancel to return to the current
worksheet.
More than one workbook file can be open at a time and can be viewed by using
the commands on the Window File menu (refer to section 6.5 Window Menu).
The Open Workbook command can be accessed on all worksheet Toolbars. This
command can also be used by pressing Ctrl + O.
• Open Workbook Button:
6.1.3 Close Workbook
Select the Close Workbook command from the File menu to close the current workbook.
If there is a second workbook open, closing a workbook will return to the previous
workbook.
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6.1.4 Import
The Import command imports existing SM.O.L.E. (.bin) GM.O.L.E. (.bin) and SMFW
(.mdm), files into the Spreadsheet worksheet. This process will copy all documentation
information (i.e. part, process) from the file being imported, into the user definable cells
on the Spreadsheet worksheet. The data can now be saved in the new format as
described under the Save and Save As menu commands.
When importing (.MDM) files, they are automatically copied into the directory of
the current workbook file.
When importing (*.bin) files they are accompanied by a corresponding hidden *.doc file.
The file pairs MUST remain together in the same directory while you are importing
them. If you wish to move some of these files to a new directory before importing, be
sure to find the matching (*.bin) and (*.doc) files and keep them together.
To import:
1. Select the Import command from the File menu and the Import list box appears.

Figure 6-11: Import List Box

2. Navigate to the file folder where the file(s) to import are located. (The path and
file name can also be typed in the File of type text box).
3. Select the file(s) to import by clicking it once.
4. Click the Open command button.
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6.1.5 Save Workbook
Select the Save Workbook command from the File menu to save the current workbook
file after changes have been made. When the user saves the file, all of the current data
runs and options in the workbook are saved.
The Save Workbook command can be accessed on all of the worksheet Toolbars. This
command can also be used by pressing Ctrl + S.
• Save Workbook Button:
6.1.6 Save Workbook As
Select the Save Workbook As command from the File menu to save the current workbook
with a different file name. When the user saves the file, the current appearance of the
workbook and the options that have been set are saved.

Figure 6-12: Save Workbook As List Box

The Save Workbook As command can also be used to save selected data runs out of a
worksheet that includes a large data set. When unwanted data runs are filtered out of a
large data set and then the Save Workbook As command is used, the selected data
runs are saved in a new workbook file along with the profile data.
This command is also useful when the user wants to transfer selected MDM data
run(s) to a floppy disk.
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6.1.7 Save As Text
Select Save As Text from the File menu to save the Spreadsheet information as a text
file in the current language, unit of temperature and distance configurations. The saved
text files have a file extension of (.TXT). This command will save the data so it can be
opened with software programs that open standard text files.

Figure 6-13: Save As Text Dialog Box

6.1.8 Save as Text Archive
Select the Save As Text Archive command from the File menu to save all of the data sets
in the workbook file as a text archive with a file extension of (.ORA). This is a useful way
to save large worksheets because text archive files are much smaller than saving in
workbook file format. This allows saving large workbook spreadsheet data in a
compressed format. They can be restored using the Load Text Archive command.

Figure 6-14: Save As Text Archive List Box
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6.1.9 Load Text Archive
Select the Load Text Archive command from the File menu to load a previously saved
text archive file. This command will clear the currently loaded data and load the selected
text archive file in its place.

Figure 6-15: Load Text Archive List Box

To avoid loosing valuable data, it is recommended to load text archive files into a
new workbook file because as previously stated, this command clears all
currently loaded data.
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6.1.10 Configuration
The Configuration command is used to set a communication (COM) port so the PC and
the M.O.L.E. can communicate. This command is very important when the software is
first installed or PC hardware configurations have changed.
To configure a COM port:
1. Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2. Select the Configuration command from the File menu on the Admin worksheet
and the Configuration dialog box appears.

Figure 6 16: Port Configuration Dialog Box

3. Click the option button next to a COM port which the PC is set up for RS-232
communications or the Auto command button to have the software automatically
find the COM port the M.O.L.E. is connected.
4. Click the OK command button accept or Cancel to exit without changing.
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6.1.11 Preferences
The Preferences sub-menu lets the user perform custom setup tasks for the software.

Figure 6-17: Preferences Menu

6.1.11.1 Units
The software can be configured to operate with different units of temperature and
distance.
This command does not set the units reported by the M.O.L.E. It applies only to
the software.
To change Units of Temperature or Distance Units:
1. Click the Units command from the Preferences sub-menu.
2. Click the option button beside a unit of temperature and/or unit of distance.
3. Click the OK command button to use the choices as defaults whenever the
software is started or Cancel to return to the worksheet without making any
changes.

Figure 6-18: Units Configuration Window

♦90♦

OvenRIDER® NL

6.1.11.2 Passwords
The software has a password protection feature that uses case-sensitive text for
securing access to a worksheet. When a worksheet is password protected, the
worksheet tab will be highlighted in yellow and the user will not be able to access the
protected worksheet without proper password privileges.
If there are worksheets password protected, the password protect command will not
affect data when uploading from the M.O.L.E.. The protected worksheets just cannot be
viewed without the password.
Once the user opens a workbook and uses the Passwords command to gain access to
a protected worksheet all of the worksheets remain unprotected until that workbook is
closed.
The password command also works on a global basis. The password currently assigned
applies to all existing or new workbook files.
The software has a default password Admin. This password will be needed the
first time the password is changed or to password protect a worksheet. When the
password is changed it is very important to remember the password or write it
down.
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To password protect worksheets:
1. Click the Passwords command from the Preferences sub-menu, and a Password
protection dialog box appears.

Figure 6-19: Password Protection Dialog Box

2. Select which worksheet(s) to password protected by clicking the corresponding
check box.
3. Click the OK command button to accept or Cancel to return to the worksheet
without password protecting any worksheet(s).
If the OK command button has been selected, a dialog box appears prompting the user
to enter the current password.
If the default password has not been changed, the current password is Admin.

Figure 6-20: Enter Password Dialog box

4. Enter the current password in the text box and click the OK command button to
accept or Cancel to return to the worksheet without password protecting the
selected worksheet(s).
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To change a password:
1. Select the Passwords command from the Preferences sub-menu and a Password
protection dialog box appears.

Figure 6-21: Password Protection Dialog Box

2. Click the Change Password command button and the Password Change dialog
box appears.

Figure 6-22: Change Password Dialog Box.

The software has a default password Admin. When the password is changed for
the first time, Admin will need to be entered in the “Current Password” text box.
3. Enter current password in the Current Password text box.
4. Enter a new password in the New Password text box.
The software only accepts passwords with a minimum of 4 characters.
•

Enter the new password again in the Confirmation text box and then click the OK
command button to accept or Cancel to not change the password.
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To disable a password:
1. Select the Passwords command from the Preferences sub-menu and a Password
protection dialog box appears.

Figure 6-23: Password Protection Dialog Box

2. The current password protected worksheet(s) will have a check mark in the
corresponding check box. Click the check box to remove the check mark to
unprotect the worksheet.
3. Click the OK command button and a dialog box appears asking the user to enter
the current password.

Figure 6-24: Enter Password Dialog box

The software has the default case-sensitive password Admin. When password
protection is removed from a worksheet and the preset password has not
changed, Admin will need to be entered in the password text box.
4. The current password must now be entered in the text box. When finished click
the OK command button or Cancel to keep the current password protection.
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6.1.11.3 File Tag Number
When data is uploaded from the M.O.L.E., the (*.MDM) portion of the data run is
automatically assigned a special File Tag number. The first two characters are
automatically assigned OR. The next nine characters are the first nine characters from
the User/Computer login name and the remaining six characters are in numerical
sequence that can be specified by the user.
For example, if the User login name is “JSMITH”, a File Tag number would be
“OR_JSMITH_000100.mdm”.
If there is no User login name available, the software will automatically assign the
first nine characters from the Computer name (i.e. Production, Engineering). If
both the User name and Computer name are not available “USER” will be
assigned to the File Tag number (i.e. OR_USER_000100.mdm).
To change the File Tag number sequence:
1. Select the File Tag Number command from the File menu.
2. A dialog box appears so a file tag number can be entered in the text box, or the
number automatically assigned by the software can be used.

Figure 6-25: File Tag Number Dialog Box

3. Click the OK command button to set the File Tag Number or click Cancel to close
the window without changing the number.
If a file tag number is entered that currently exists, the (.MDM) file will be
incremented automatically to avoid that file from being overwritten.
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6.1.12 Print Options
The Print Options command is where additional Data Table statistics can be selected to
be printed along with the Data Graph. Additional documentation can also be selected
that will be printed on a second page.
To select print options:
1) Select the Print Options command from the File menu and the following dialog
box appears.

Figure 6-26: Print Options Dialog Box

2) Click the check box beside desired Statistic(s) to be printed along with the Main
Plot.
3) Click the check box beside desired documentation to be printed on a second
page.
•

Click the Print command button to close the print options process and initiate
printing.

•

Click the Print Preview command button to view the report appearance.

4) Click the OK command button to accept or Cancel command button to leave the
print options command without making any changes.
This command can also be used by pressing CTRL + I.
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6.1.13 Page Setup
The Page Setup command sets page parameters for the Spreadsheet and Admin
worksheets.
To set page parameters:
1. Select the Page Setup command from the File menu and the following dialog box
appears.

Figure 6-27: Page Setup Dialog Box

2. Select desired parameters to apply to the worksheet.
3. Click the OK command button to use the current page setup selections.
4. Click the Cancel command button to leave the page setup command without
changing anything.
Selections made using the Page Setup command will not be visible on the
worksheet it is only used for print formatting. To view the selections, use the Print
Preview command decsribed in section 6.1.15 Print Preview.
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6.1.14 Page Header / Footer
The Page Header / Footer command places text on the top and bottom of the printed
worksheet.
Some of the worksheets contain default information in the Header and Footer
fields, to view use the Print Preview command. Refer to section 6.1.15 Print
Preview.
To add a Header and/or Footer
1. Select the Page Header/Footer command from the File menu and the following
dialog box appears.

Figure 6-28: Header / Footer Dialog Box

2. Click the Header tab or the Footer tab.
3. Determine where to locate the text: left, center or right side of the worksheet.
Click a text field and type the desired text.
•

The user can also change the text font, distance the note is from the frame edges
and type of page numbering.

4. Click the OK command button to accept the Header / Footer or click Cancel to
return to the worksheet without changes.
The Header / Footer information will not be visible on the worksheet. It is only
used for printing. To view the Header / Footer information, use the Print Preview
command (refer to section 6.1.15 Print Preview).
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6.1.15 Print Preview
The Print Preview command shows a preview of the page(s) to be printed. This
command is useful when confirming print options.
To view a print preview:
1. Select the Print Preview command from the File menu and the Print Preview
window appears.

Figure 6-29: Print Preview Window

2. Click the Print command button to proceed with printing.
3. Click the Two-Page command button when there is more than one page in the
report to view them side by side.
4. Click the Next Page or Prev Page command button to view other pages of a
multiple page report.
5. Click the Zoom In command button to observe small details, and Zoom Out to
restore.
6. Click the Close command button to close the Print Preview window.
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6.1.16 Print
The Print command prints worksheet information from the workbook. The options that
appear on the Print dialog box will depend on the type of printer and the installed printer
driver.
To print a worksheet:
1. Select the Print command from the File menu and standard Windows or driverdependent print dialog box appears.
2. Select desired print options.

Figure 6-30: Print Dialog Box

3. Click the OK command button to close the Print dialog box and initiate printing
the worksheet.
4. Click the Cancel command button to close the print window without printing.
The Print command can be accessed on all worksheet Toolbars. This command can
also be used by pressing Ctrl + P
• Print Button:
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6.1.17 Report Setup
Select the Print Report command from the File menu to print the selected worksheets
from the Report worksheet as discussed in section 6.1.18 Print Report.
To setup a report:
1. Select the Report Setup command from the File menu and the Report Setup
dialog box appears.

Figure 6-31: Report Setup Dialog Box

2. Click the check box(es) to enable the worksheet(s) to be printed.
3. Click the OK command button to accept the selection(s) and return to the
worksheet, or click Cancel to return to the worksheet without any changes.
6.1.18 Print Report
Select the Print Report command from the File menu to print the selected worksheets
from the Report Setup dialog box as discussed in section 6.1.17 Report Setup.
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6.1.19 Send to Mail Recipients
The Send to Mail Recipients sub-menu commands let the user send a Screen image,
MDM, or Workbook and associated MDM’s to an email recipient. This command is
useful when the user would like to share profiles and/or workbooks with other locations
or when troubleshooting problems.

Figure 6-32: Preferences Menu

To send:
1. Launch an email program (i.e. Outlook, endora).
2. Select the desired email command described below:
•

Select Screen Image to capture the current displayed worksheet screen.

When selecting the Screen Image command, the software captures the current
screen image where the command is activated and converts it into a Bitmap
(filetag.bmp) file.
•

Select MDM File to send the MDM file from the currently selected data run.

•

Select Workbook and associated MDM’s to send the current Workbook and
associated MDM files.

3. Enter an email address in the email text box and select the OK command button
to send the file and return to the worksheet where the command was activated.

Figure 6-33: Enter Recipients

When sending files the email program may display an message dialog that
informs the user that it is sending the email.

♦102♦

OvenRIDER® NL

6.1.20 Recent Files 1, 2, 3, etc...
The most recently loaded workbook file names are displayed at the bottom of the File
menu. To open one of these files, click the name of the desired workbook file or press
the appropriate number beside it.
6.1.21 Exit
Select the Exit command to quit OR SPC program. A message box will prompt the user
to save changes. If the user decides to save the changes, all data and configuration
changes will be saved with the workbook file.
6.1.22 Language
All of the menus and commands have been translated in seven different languages.
After the software is installed, the user can select a different language from the
Languages sub-menu in the File menu.
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6.2 Edit Menu
The Edit menu commands enable the user to modify the data set on the Spreadsheet
and Admin worksheets so the most beneficial data is assembled in the workbook file.
6.2.1 Undo
Select the Undo command to undo any previous action. For example if the filter
command is used and then the user decides that command was not necessary, the
Undo command will restore it back to its original format.
The Undo command can be accessed on the Toolbars of the Spreadsheet and Admin
worksheets. This command can also be used by pressing CTRL + Z.
• Undo Button:
6.2.2 Redo
Select the Redo command to restore the action made by using the Undo command. Like
Undo, the user can use Redo to restore all of the Undo actions.
The Redo command can be accessed on the Toolbars of the Spreadsheet and Admin
worksheets. This command can also be used by pressing CTRL + R.
Redo Button:
6.2.3 Copy
Select the copy command to copy the data in the Spreadsheet cells for pasting into
other user definable cells or different programs. This command can also be used by
pressing CTRL +C.
6.2.4 Paste
Select the Paste command to insert collected data in the user definable cells or different
programs. This command can also be used by pressing CTRL +V.
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6.2.5 Remove Row
Select the Remove Row command to remove a data run row that is not wanted. This
command is helpful when data has been collected and the user feels it is not beneficial
to the workbook data set or has a corrupted MDM file.
This command permanently removes the user configurable data. However, the
associated (.MDM) file will not be deleted and can be retrieved using the Import
command (refer to section 6.1.4 Import).
6.2.6 Hide Row
Select the Hide Row command to exclude a row without eliminating it completely from
the workbook file. This command is similar to the filter function, and is helpful when data
has been collected and it may not be beneficial to the data set. To restore hidden data
set row(s) click the Red Filter Reset button located on the Spreadsheet worksheet (refer
to section 5.3.7 Filters).
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6.3 View Menu
The View menu commands enable the user to manipulate which areas are viewed on
the worksheet display.
6.3.1 Zoom In
Select the Zoom In command from the View menu to make the current worksheet view
larger. The Zoom In command has the capability to zoom in multiple times. When the
maximum zoom level has been reached the Zoom In command will be dimmed.
The Zoom In command can be on all worksheet Toolbars excluding the Profile
worksheet. This button will speed up the Zoom In process if multiple zooms are desired.
• Zoom In Button:
6.3.2 Zoom Out
Select the Zoom Out command from the View menu to make the current worksheet view
smaller. The Zoom Out command has the capability to zoom out multiple times. When
the minimum zoom has been reached the Zoom Out command will be dimmed.
The Zoom Out command can be accessed on all worksheet Toolbars excluding the
Profile worksheet. This button will speed up the Zoom Out process if multiple zooms are
desired.
• Zoom Out Button:
6.3.3 100%
Select the 100% command from the View menu to return the worksheet to its default
display size.
The 100% command can be accessed on all worksheet Toolbars excluding the Profile
worksheet.
• 100% Button:
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6.4 Format Menu
The Format menu includes commands that change the layout or pattern of the text in
user configurable cells.
6.4.1 Bold
Select the Bold command from the Format menu to turn data in a user configurable cell
bold. Select the Bold command again to return to standard format.
The Bold command can be accessed on the Toolbar of the Spreadsheet and Admin
worksheets.
• Bold Button:
6.4.2 Italic
Select the Italic command from the Format menu to turn data in a user configurable cell
italic. Select the Italic command again to return to standard format.
The Italic command can be accessed on the Toolbar of the Spreadsheet and Admin
worksheets.
• Italic Button:
6.4.3 Underline
Select the Underline command from the Format menu to underline data in a user
configurable cell. Select the underline command again to return to standard format.
The Underline command can be accessed on the Toolbar of the Spreadsheet and
Admin worksheets.
• Underline Button:
6.4.4 Alignment (Left, Center, Right)
Select the Left, Center or Right command from the Format menu to align data in a user
configurable cell.
The alignment commands can be accessed on the Toolbar of the Spreadsheet and
Admin worksheet.
• Alignment Buttons:
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6.5 Window Menu
The Window menu arranges opened workbook files for viewing and quick access.
6.5.1 Cascade
Select the Cascade command from the Window menu to cascade opened workbook files
from the upper left corner overlapping the workbooks downward so each workbook Title
bar is visible.

Figure 6-34: Cascaded Workbook Files
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6.5.2 Tile
Select the Tile command from the Windows menu to arrange the open workbook files in
a rectangular fashion dividing the workbook files into smaller sizes arranged so they fit
next to each other on the display.

Figure 6-35: Tiled Workbook Files

6.5.3 Open File
This section of the Window menu shows the currently opened workbook files. This
allows quick access to all of the opened workbook files. Selecting a workbook file name
to bring it to the front of the opened workbooks and make it active.
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6.6 OvenRIDER Menu
The OvenRIDER menu commands configure the M.O.L.E. for collecting data.
The M.O.L.E. must be connected to a PC and the proper communication port
must be configured to properly use the OvenRIDER menu commands.
6.6.1 Configuration Wizard
This wizard guides a user through the communications setup process so the software
and M.O.L.E. can communicate. Communications configuration needs to be done when
the software is first installed or PC hardware configurations have changed.
The wizard steps can be accessed individually on the File and OvenRIDER menus.
To configure communications:
1. Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2. Select the Configuration Wizard command from the M.O.L.E. menu and the
Configuration dialog box appears.

Figure 6-36: Wizard Step 1 – Configuration

3. Click the option button next to a COM port which the PC is set up for RS-232
communications or the Auto command button to have the software automatically
find the COM port the M.O.L.E. is connected.
4. Click the OK command button to use the selection and continue to the
OvenRIDER Settings dialog box.
The user can exit the Configuration Wizard any time by selecting the Cancel
button.
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5. Type a company, operator, or machine name in the text box.

Figure 6-37: Wizard Step 2 – M.O.L.E. Settings

6. Click the OK command button to store the information in the M.O.L.E. and
continue to the Set Instruments Clock dialog box.
7. Enter the correct month, day, year, hour, minute, and second by adjusting the
slider(s) or manually typing in the corresponding text box.

Figure 6-38: Wizard Step 3 -Set Instrument Clock

When the Set Instrument Clock dialog box appears the current computer clock
setting is automatically entered in the text boxes.
8. Click the OK button to reset the clock.
Configuration is now complete and the M.O.L.E. is ready to collect data.
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6.6.2 Set M.O.L.E. Clock
The M.O.L.E. has an internal clock it uses to identify the time and date of each data run
and to control when each measurement is recorded. The M.O.L.E. clock should be set
prior to data collection to ensure that the proper time was recorded.

Figure 6-39: Set Instrument Clock Dialog Box

To set the M.O.L.E. clock:
1. Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2. Select the Set M.O.L.E. Clock command from the OvenRIDER menu.
3. Enter the correct month, day, year, hour, minute, and second by adjusting the
slider(s) or manually typing in the corresponding text box.
When the Set Instrument Clock dialog box appears the current computer clock
setting is automatically entered in the text boxes.
4. Click the Send button to reset the clock.
When the setting of the clock is completed, a dialog box with the configuration data
appears.
To read the M.O.L.E. clock:
1. Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2. Select the Set M.O.L.E. Clock command from the OvenRIDER menu.
3. Click the Read command button to display the current date and time from the
M.O.L.E.. If the clock is set wrong, the date or time will be incorrect.
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6.6.3 OvenRIDER Settings
The M.O.L.E. can be configured to store the name of your company, operator or
machine name.
To select M.O.L.E. settings:
1. Insert the M.O.L.E. into the Station.
2. Select the M.O.L.E. Settings command from the M.O.L.E. menu.
3. Type a company, operator, or machine name in the text box.

Figure 6-40: Printout Configuration Window

4. Click the Send command button to store the information in the M.O.L.E.
5. When the process is complete, a dialog box appears confirming the information
sent. Click the OK command button and the Set M.O.L.E. Clock dialog box
appears for verification of the clock settings. Click the OK command button and
the software will return to the worksheet.
Using this command may cause the M.O.L.E. to lose any previous data collected.
The OvenRIDER Settings command can be accessed on the Toolbars of the
Spreadsheet, Profile, and Admin worksheets.
• OvenRIDER Setting Button:
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6.6.4 Read OvenRIDER Data
The Read OvenRIDER Data command starts the data transfer process after completing
the data collection process.
To read OvenRIDER data:
1. Connect the M.O.L.E. to the PC (refer to the appropriate section in the Hardware
manual).
2. Select the Read OvenRIDER Data command from the OvenRIDER menu and a
status bar dialog box appears indicating that data retrieval from the M.O.L.E. has
begun.

Figure 6-41: Read OvenRIDER Dialog Box

Once data transfer is complete, the dialog box will disappear and will return to the
current worksheet.
If the OvenRIDER detects less than 2 Zone Magnets, the software will inform the
user and prompt them to decide if they wish to use oven model data from the
AutoM.O.L.E. mailbox, or the previous profile.
The Read OvenRIDER Data command can be accessed on all worksheet Toolbars.
• Read OvenRIDER Data Button:
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6.7 Profile Menu
The Profile menu includes special commands specifically used on the Profile worksheet.
Commands in this menu enable the user to view and edit experimental documentation,
change the appearance of the display and design experiments.
6.7.1 Part
Part documentation is information about the part being profiled. There are also fields for
entering the date the data was recorded, a user name, part number or identification of
the component being profiled. To enter Part Documentation select the Part command
from the Profile menu and a dialog box appears.
The part date field automatically updates when reading data from the M.O.L.E.

Figure 6-42: Part Dialog Box
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6.7.2 Process
Select the Process command from the Profile menu to enter and edit information about
the process that generated the profile data.

Figure 6-43: Process Dialog Box
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6.7.3 Scaling
The Scaling command controls the scale of the X and Y axis units of the Data Graph on
the Profile worksheet.
To use the scaling command:
1. Select the Scaling command from the Profile menu, and the scaling dialog box
appears. This dialog box identifies the current settings of the displayed Y-axis
units and the maximum and minimum values of the Y-axis.

Figure 6-44: Scaling Window

2. Select between Auto or Manual mode. In Auto mode, the software selects the
scale of the Y-axis to ensure all data point values and the highest zone
temperature settings are visible in the Data Graph. In Manual mode, the range of
values for the Y-axis can be manually set.
3. Click the OK button to use the new settings or Cancel to return to the Profile
worksheet with no changes.
The Scaling command is not avalible if the Data Graph has been magnified.
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6.7.4 Units
The Units command is where the unit type for the X-axis is selected.
To select a X axis unit:
1. Select the Units command from the Profile menu and the Units dialog box
appears.

Figure 6-45: Units Dialog Box

2. Click the option button beside Point, Time or Distance to select the units for the Xaxis.
•

Point: the data points collected from the Process Origin.

•

Time: Time measured from the Process Origin

•

Distance: Distance from the Process Origin (Meters, Centimeters, Feet or
Inches).

3. Click the OK command button to return to the worksheet using the new settings
or Cancel to make no new changes.
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6.7.5 Temp Ref Lines (Temperature Reference Lines)
Temperature Reference Lines are colored horizontal lines and can be positioned
anywhere within the range of Y-values in the graph using the Temp Ref Lines command
in the Profile menu.
Temperature Reference Lines are used for analysis when the T Above Ref
(Time above the Reference Line) statistic is active (refer to section 5.4.9.3 T Above
Ref).

Figure 6-46: Temp Ref Lines Dialog Box

The Temp Ref Lines dialog box identifies the units of the Y-axis and the current values
of any Temperature reference lines in the Data Graph. Temperature reference lines can
be added or changed at any time and must be created before the T Above Ref statistic
will produce valid data in the Data Table.
To add Temperature Reference Lines to the Data Graph:
1. Select the Temp Ref Lines command from the Profile menu.
2. Click the check box above Low, Med, or Hi to draw that line in the graph.
3. Enter Y-axis value(s) by adjusting the slider position or typing it in the text box.
4. Click the OK command to return to the Profile worksheet using the new settings
or Cancel to not make any changes.
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6.7.6 Profile Colors
The Profile Colors command changes the display and print colors for the sensor Data
Plots.
To change sensor channel colors:
1. Select Profile Colors from the Profile menu and the Select Colors dialog box
appears.
When the colors are changed it will affect all existing and new workbooks.

Figure 6-47: Profile Colors Dialog Box

2. Click the desired sensor and a Windows default color pallet appears.
3. Selected a new color and click the OK command button to accept and exit the
color pallet. (Repeat for all of the other channels).
4 Click the OK command to accept or Cancel to not make any changes.
y
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Click the Defaults command button to restore the colors to the original default
colors.
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6.8 Tools Menu
Options in this menu help you manipulate and analyze the profile data.
6.8.1 Magnify Tool
The Magnify tool enlarges any selected area of the data graph for easy visual
examination.
To Magnify a portion of the Data Graph:
1. Click the Magnify tool from the Tools menu.
2. Position the mouse pointer on a corner of the area to enlarge.
3. Press the left mouse button and drag the pointer diagonally to the opposite
corner to form a box around the area to be magnified. An outline of the box
appears as you drag.
4. Release the left mouse button when the outline of the area to be magnified is
visible. The area inside the box is then magnified to fill the entire Data Graph.
To show even more detail in the Data Graph, Magnify can be performed multiple
times. If the Magnify tool reaches the maximum zoom capability the software will
display a message box informing that the user has “Zoomed to Tight”.
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When using the Magnify tool, the Magnify Map uses a red box to indicate the area
currently magnified. If the Data Graph was previously magnified, the current level of
magnification is the red box and previous magnified areas are noted with gray boxes.

MAGNIFIED
AREA
MAGNIFY
MAP

Figure 6-48: Magnify Map

When the Magnify tool has been used multiple times, click a red box in the Magnify map
once to go back to a previously selected level of magnification or the white area to
return to the full view.
Magnify Applications:
Magnify is useful for visually examining data, when statistics are used. The statistics
(Value, Time to Ref., T Above Ref, and Statistics) compute only data points that fall
within the area of the Data Graph. This enables the user to focus the statistical analysis
on any portion of time, distance, or data point number in the graph.
The Magnify command can be accessed on the Profile worksheet Toolbar.
Magnify Button:

♦122♦

OvenRIDER® NL

6.8.2 Slope Tool
The Slope tool finds the average slope between any two points in the Data Graph.
To find the average slope of a line:
1. Select the Slope tool from the Tools menu.
2. Position the mouse pointer at a point on the curve.
3. Press and hold the left mouse button.
4. Drag the pointer to the end of the desired slope line.
5. Release the left mouse button when the pointer is at the desired location. The
software will draw a slope line on the Data Graph, and label the slope value.

SLOPE
LINE
SLOPE
DATA

Figure 6-49: Slope Tool

OvenRIDER® NL

♦123♦

To obtain more accurate slopes:
Magnify a portion of the Data Graph using the Magnify tool, and repeat this procedure.
To remove the slope line from the Data Graph, select the Erase Object(s) command from
the Tool menu and follow instructions in the Tool Status box (refer to section (See
section 6.8.8 Erase Object(s)).
Slope Applications:
Use the Slope tool to find the average slope between any two points on the graph.
Longer slope lines tend to produce more accurate slope calculations.
The Slope tool can be used to compare actual data with ideal conditions by drawing a
line with a known slope (to represent the ideal condition) beside a portion of a Data Plot.
Slope Limitations:
Slope calculations are based on logged points connected by the slope line. Points occur
only at the exact time intervals used to record data.
The Slope tool cannot measure slopes when dx (change in X) is equal to zero (when
the line is vertical).
The Slope tool can be accessed on the Profile worksheet Toolbar.
• Slope Button:
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6.8.3 Peak Difference Tool
The Peak Difference tool displays the difference in value between the peak of the
maximum Data Plot and the peak of the minimum Data Plot in any location of the Data
Graph. This command is especially useful for measuring side-to-side heating
differences in ovens.
To display the peak difference between Data Plots:
1. Select the Peak Difference tool from the Profile menu.
2. Position the mouse pointer on a corner of the area you want to analyze.
3. Press the left mouse button and drag the pointer diagonally to the opposite
corner to form a Peak difference box. An outline of the box appears as you drag.
The peak difference is calculated as the maximum difference between the highest peak
and the lowest peak within the rectangle.
To remove the peak difference rectangle and annotation from the Data Graph,
select the Erase Objects command from the Tools menu and follow instructions in
the Tool status box (See section 6.8.8 Erase Object(s)).

PEAK
DIFFERENCE

Figure 6-50: Peak Difference Tool

The Peak Difference tool can be accessed on the Profile worksheet Toolbar.
• Peak Difference Button:
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6.8.4 Overlay Tool
The Overlay tool displays a second process reference Data Graph from another data
The Overlay tool displays a second Data run profile for comparison with the currently
displayed Data run.
To compare two Data Plots:
1. Click the Overlay tool from the Tools menu. A list box of data files uploaded into
the opened workbook appears.
2. Select a data run file to overlay on the original by clicking it.
The data file will be inserted at the same process origin and automatically scaled to the
same Y-axis with the Overlaid file name displayed in the Tool status box. The original
Data Plot remains as solid lines while those added for comparison are dashed.
The dashed “Overlay” Data Plots are the same color as the original Data Plots.

Figure 6-51: Overlay Tool

•
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To remove the overlaid Data Graph from the original Data Graph select the
Overlay tool again or press the right mouse button.
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Overlay Applications:
The Overlay and Magnify tools can be used together to overlay and compare ideal
reference profiles and magnified portions of the two data files. They can have different
but overlapping X-values (times, point numbers, logging intervals) or temperatures.
Overlay Limitations:
If the Data Plots are too numerous to clearly see the information of interest, they can be
suppressed by removing the check mark from the desired channel in one or both files.
This must be done to the overlaid profile prior to using the Overlay tool. Save that graph
and use the Overlay tool again.
The Overlay tool can be accessed on the Profile worksheet Toolbar.
• Overlay Button:
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6.8.5 3-D View
The 3-D tool draws a 3-dimensional representation of the temperature data. When the
3-D tool is selected a dialog box appears prompting the user to select a “Normal” or a
“Reverse-Angle” view. A “Normal” view shows the Ambient sensor A in back and
Ambient sensor C in front, and a “Reverse-Angle” view shows Ambient sensor C in the
back and Ambient sensor A in front.
The 3-D profile is useful for comparing the general smoothness of the Data Plots for
each sensor or showing uniform heating across an oven.

Figure 6-52: Normal View
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Figure 6-53: Reverse-Angle View

To remove the 3-D profile, click the 3D tool, or click the right mouse button.
The 3-D tool can be accessed on the Profile worksheet Toolbar.
• 3-D Button:
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6.8.6 Measure Tool
The Measure tool is similar to the Slope tool except it measures the distance between
any two points on the Profile worksheet Data Graph. This tool adds a line labeled with
the distance values to the graph, and notes the change in X and change in Y (Delta X
and Delta Y) instead of the slope.

MEASURE
DISTANCE

Figure 6-54: Measure Tool
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To find the distance between two points:
1. Select the Measure tool from the Tools menu.
2. Position the mouse pointer at a point on the curve.
3. Press and hold the left mouse button.
4. Drag the pointer to the end of the desired point on the curve.
5. Release the left mouse button when the pointer is at the desired location and a
slope line labeled with the change in X and Y appears on the Data Graph.
To obtain more accurate distances, magnify a portion of the Data Graph using the
Magnify tool and repeat this procedure.
To remove the annotated distance from the Data Graph, select the Erase Objects
command from the Tools menu and follow instructions in the Tool status box (See
section 6.8.8 Erase Object(s)).
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6.8.7 Notes Tool
The Notes tool adds a leader with text to any portion on the Data Graph to label special
points of interest.
To add notes to the Data Graph:
1. Select the Notes tool from the Tools menu.
2. Position the mouse pointer at the desired location to start the note leader, click
and drag the mouse pointer to the desired location for the note text and release
the mouse button.
3. A dialog box will then appear allowing the user to enter a note by typing it in the
text box. There also are options to customize the color, border and font size of
the notes.

Figure 6-55: Notes Dialog Box

4. Click the OK command button or press the [enter] key to finish adding the note.
To remove notes from the Data Graph, select the Erase Objects command from the
Tools menu and follow instructions in the Tool status box (See section 6.8.8 Erase
Object(s)).
The Notes tool can be accessed on the Profile worksheet Toolbar.
• Notes Button:
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6.8.8 Erase Object(s)
The Erase Object(s) command deletes objects and information that have been added to
the Data Graph.
To erase object(s):
1. Select the Erase Object(s) command from the Tools menu.
2. Position the mouse pointer beside the object(s) to erase.
3. Press the left mouse button and drag diagonally to outline the object(s) to be
deleted.
4. A message box asking, “Do you wish to erase this object?” appears for each object
selected. (The object that the question is referring to will be surrounded by a red
dashed box).
5. Click the Yes command button to continue erasing, or the No command button to
cancel the operation.
If the Erase Objects command is selected and there are no object(s) to be deleted,
click the right mouse button to escape from that command.
The Erase Object(s) command can be accessed on the Profile worksheet Toolbar.
• Erase Object(s) Button:
6.8.9 Erase All
The Erase All command deletes, in one operation, all the objects and information that
have been added to the Data Graph.
This operation is not reversable, so use with CAUTION.
To erase all objects:
1. Select the Erase All command from the Tools menu.
2. A message box appears asking, “Do you really want to erase all your objects”.
3. Click the Yes command button to continue erasing, or the No command button to
cancel the operation.
If the Erase All command is selected and there are no object(s) to be deleted, the
erase all command will simply redraw the screen.
The Erase All command can be accessed on the Toolbar of the Set & Verify worksheet.
• Erase All Button:
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6.9 Manual Zones
The commands on the Manual Zones menu sets zone boundaries in the oven up and
creates a model of ideal processes that the software can use to compare experimental
conditions.
6.9.1 Manual Zone Definition
The Manual Zone Definition command allows the user define the number of zones
activated, color, name and length.
To activate Manual Zones:
1. Select the Manual Zone Definition command from the Manual Zones menu to
activate. A check mark appears to the left indicating the software is in Manual
Zone Definition mode. The Oven Dialog box appears where the user can define
the number of zones activated, color, name and length. (Refer to section 6.9.2
Setup Zones for more information).

Figure 6- 56: Oven Settings

2. Once the settings are acceptable, click the OK command button to return to the
Profile worksheet to view.
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An Update Spreadsheet button appears in the lower right corner of the Data
Graph. When clicked it will update the selected profile data on the Spreadsheet
worksheet with the new zone/oven settings.
3. Fine tune the oven settings by adjusting process origin, values in the Zone Matrix
or manually moving the Zone Boundary handles.
ZONE BOUNDARY HANDLES

Figure 6-57: Manual Zone Detection

4. Lock the settings by selecting the Manual Zone Definition command again. This
removes the check mark next to the command indicating the software is not in
Manual Zone Definition mode.
These new settings can be saved as an oven model. Refer to section 6.9.2 Setup
Zones for more information.
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6.9.2 Setup Zones
The Setup Zones command sets the conveyor speed, zone colors, displays zone
boundaries in the Data Graph and saves or loads oven settings.
To setup zones:
1. Select the Manual Zone Definition command to activate the manual zones, or
choose Setup Zones, if the Manual Zone Definition is already activated. When
either of these commands are selected the Oven dialog box appears.

Figure 6-58: Manual Zones Dialog Box
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2. Click the corresponding check box beside a zone to activate or deactivate it.
3. Click the corresponding Color field to select a different color for that zone. Click
the Default Colors command button to restore.
4. Click the corresponding Name field to enter a custom zone name if desired.
5. Click the option button beside the appropriate units of length or time for the
process. Select between units of length: meters, centimeters, feet, inches or
between units of time: hours or minutes.
6. Click the corresponding Length field to enter a specific zone length for each zone.
7. Enter the conveyor speed to identify the actual speed of the conveyor when the
OvenRIDER was recording data. The software uses this value to calculate the Xaxis values when you choose the Distance option for the X-axis units.
Conveyor Speed can not be set or viewed if the Data Graph has been magnified.
8. Click the OK command button to accept the current setup or to create new
zone(s) and oven settings or Cancel to quit without making any changes to the
zones.
9. An Update Spreadsheet button appears in the lower right corner of the Data
Graph. When clicked it will update the selected profile on the Spreadsheet
worksheet with the new zone/oven settings. The zones will be displayed as
colored bars along the X-axis.
To deactivate this command, click the Manual Zone Definition command again. This
will remove the check mark on the left of the command to indicate that it is in
Auto Zone Detection mode.
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Creating and Saving an Oven Model:
1. Make sure current data is saved.
2. Edit the following information to fit the desired requirements. Zone Sizes, Zone
Temperatures, Conveyor Speed (from the Oven Configuration Dialog Box) and
Part, Process, Sensor Documentation (from the Profile menu).
3. Select the Oven Configuration command from the Profile menu.
4. Click the Save command button from the Oven Model section and a list box of
oven files appears.
5. Enter the file name in the text box. The extension assigned to this file is (.OVN).
6. Click the Save command button.
The new Oven Model is now ready to use
Process information will only be used if there is no process information in the
data set that exists when an Oven Model is loaded.
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To load an Oven Model:
1. Select the Oven Configure command from the Profile menu.
2. Click the Load command button in the Oven Model section.

OVEN COMMAND BUTTONS

Figure 6-59: Oven Model Commands
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3. A list box of oven files with an extension (.OVN) appears.

Figure 6-60: Load Oven Model List Box

4. Select the desired oven model by clicking it once.
5. Click the Open command button.
Loading an oven model will overlay the current data set with the following information:
•

Zone Size Information

•

Zone Temperature Information

•

Conveyor Speed Information
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6.10 Navigate Menu
When viewing a data run on the Profile worksheet, the Navigate menu allows the user
to view other Profiles without having to select them from the Spreadsheet worksheet. It
enables the user to view profiles that are one above or below the one currently being
viewed, or jump to the first or last one uploaded into the open workbook.
• Navigate Buttons
The Navigate commands can be accessed on the OvenRIDER and Profile worksheet
Toolbars.
DATA RUN DROP
DOWN LIST
FIRST DATA RUN

LAST DATA RUN

BACK TO PREVIOUS
DATA RUN

FORWARD TO
NEXT DATA RUN

Figure 6-61: Navigate Tool Buttons
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6.11 Help Menu
The Help menu commands are useful when information is needed quickly or when this
Users guide is not available.
6.11.1 Help
The Help Index is a complete reference tool that can be used at any time. Select the
Help command from the Help menu and Adobe Acrobat® Reader will automatically
launch the users guide in a PDF document. You may now search for the help topic of
your choice.
6.11.2 ECD on the Web
You can access more help by using ECD web commands. Let us help you by using the
linked commands to the ECD Web site.

Figure 6-62: ECD Web Sub-Menu

6.11.3 About OvenRIDER
Select About OvenRIDER from the Help menu to display the software version, release
date and company information.
PRODUCT NAME
AND VERSION
COMPUTER
NAME
USER LOGIN
NAME

Figure 6-63: About OvenRIDER Dialog Box

The About command can be accessed on all of the worksheet Toolbars.
• About Button:
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7.0 Service and Troubleshooting
The following calibration and service instructions are for use by qualified personnel only.
Refer to the summary and service safety summary prior to performing any service.
7.1 Zone Sensor Battery
The zone sensor LED is powered by a 3.6 volt ½ AA lithium battery. If the zone sensor
LED is dim or does not illuminate when the OvenRIDER NL passes a zone boundary
magnet, check the battery to see if it has become discharged. Always replace with
SAFT lithium battery (LS 1425) or the equivalent specified.
Make sure that the OvenRIDER is not stored near any magnets. This can cause
the zone sensor LED to stay illuminated, and discharge the battery.

ZONE SENSOR BATTERY

Figure 7-1: Zone Sensor Battery Installation
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7.2 Service Troubleshooting
Check the appropriate section of the manual to be sure you’re following the correct
procedures.
Decide if the problem is with the OvenRIDER NL, M.O.L.E., or OvenRIDER SPC
Software.
Once you have decided what item in the OvenRIDER NL Kit is causing the problem,
refer to the following sections. Problems that are more likely or more easily corrected
are listed first in each section. Start at the top of the list and work your way down. If the
problem is still unresolved go to the section 5.5 How to Get Additional Help.
7.2.1 OvenRIDER Troubleshooting Steps
Decide if the problem is with the OvenRIDER NL hardware, communications or
software.
• If the problem occurs while attempting to log data, the hardware may be faulty.
•

If the problem occurs while attempting to communicate between M.O.L.E. and
the PC, the Communications links may be faulty.

•

If the problem occurs while attempting to use some other function of the
OvenRIDER SPC Software, the software may be faulty.

Incorrect or Inappropriate Readings:
Zone time or Speed measurements are dependent on proper magnet placement with in
the reflow oven. Symptoms are:
1. Odd number of zone boundary readings
•

If the front zone boundary sensors and rear zone boundary sensors do not detect
the same amount of zone magnets, the magnets may need to be re-adjusted.

2. Initial temperature rise to low
•

Process sensors may have been warmer than room temperature at the time of
the data run.

• Process sensors may have collected foreign matter (i.e. dirt, oils etc…)
Shorted or open T/Cs are the most common cause of errors. A shorted T/C will read
near room temp or respond very slow relative to the other sensors. An open T/C will
cause a sudden rise in the temperature graph printout and often 000°F or C values on
the tables.
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7.3 How to Get Additional Help
If you are having difficulties, or you wish to purchase an additional oven brand software
license, let us help you. We offer many ways to service your requests. You can call our
Service technicians or Sales department, visit our web site to view our FAQ section
(Frequently asked Questions) or send us e-mail explaining your problem in detail.
When calling our Service/Test technicians or sending us e-mail, please include the
following information:
•

Product Description (i.e. SuperM.O.L.E. Gold, OvenRIDER NL).

•

Product Serial Number.

•

M.O.L.E. firmware version. This information can be found in the M.O.L.E. Status
box on the Profile worksheet. (Refer to section 5.4.2 M.O.L.E. Status)

•

Software Version (You can find it on the Title bar of the software).

Here is how to contact ECD:
Telephone: (503) 659-6100
FAX: (503) 654-4422
Technical Support: (800) 323-4548
Email: support@ecd.com
Internet: http://www.ecd.com
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Appendix A: Specifications
Electrical/Mechanical:
Weight:

6.6” – 3.84 lbs. (1742 grams)
12” – 6.19 lbs. (2808 grams)
18” – 7.8 lbs. (3538 grams)

Physical Dimensions:

Length: 17.75” (45.1cm)
Height: 1.0” (2.54cm)
Width: 6.6” (16.8cm), 12” (30.5cm) and 18” (45.7cm).

Zone Magnets:

Material: Alnico
Weight: 0.3 oz
Length: .75 in (.29cm)
Diameter: .375 in (.15cm)
Maximum Operating Temperature: 900°F
Open circuit gauss: 800 +/-100

Data Capacity

9 minutes 6 seconds

Environmental
Temperature:
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Operating: 32°-122°F (0°-50°C)
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Appendix B: Statistical Process Control (SPC) Background Information
This appendix deals with the subset of SPC that is incorporated into OvenRIDER SPC.
It does not address general SPC principals. A working knowledge of general statistical
principals and SPC terms is assumed and is not addressed here. There are many good
basic SPC books where this information may be obtained.
Reflow oven operators, engineers and production managers are expected to
understand their reflow oven process so as to deliver quality products cost effectively.
This is a continuous process.
First, the reflow oven must be checked for consistency. A standard or typical set up
should be routinely checked prior to any process set point determinations, or actual
production run machine checks. Only after the machine has been determined to be
operating correctly and not experiencing abnormal variation, should data from the oven
be utilized. SPC is all about identifying common or normal variation from abnormal
variation.
Second, the correct process set points must be determined for a particular product.
Utilizing the ECD SuperM.O.L.E. Gold profiler, the correct set points for a particular
product may be determined. These set points, if selected correctly and followed, should
deliver the maximum throughput of quality product.
Third, the reflow oven must consistently deliver the correctly determined set points. SPC
will help identify common or normal variation from abnormal variation. Checking the
reflow oven using your ECD OvenRIDER NL with its SPC capability will help ensure that
the reflow oven is consistently performing to it’s set points and your expectations.
Fourth, repeat the above three steps. Continuous improvement is a never-ending cycle.
Check the long-term variation of the reflow oven by graphing typical set points samples.
Using the SuperM.O.L.E. Gold profiler recheck/adjust part number specific set points to
maximize your quality throughput. Check the machine during a part number run to
control the machine variation from that part number’s actual ideal set points.
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In the real world you may not want or be able to run your OvenRIDER NL through your
reflow oven continuously to collect process data. A more typical scenario is to check the
machine by running the OvenRIDER NL through periodically: once per shift, once per
day, once per week, or once after every maintenance cycle. In addition checking the
reflow oven at the start, middle or end of every part number run, at the start and end of
every part number run or once during a part number run could be typical scenarios.
Make sure you generate SPC charts based on data sets that had the same set points
each time. Otherwise the charts will not be meaningful.
While SPC had its start in high volume repetitive operations, SPC is applicable to many
other types of operations as well. However SPC can be difficult to apply to short runs.
Short runs may be run that take a short time to process, runs in which multiple samples
are difficult to collect, and runs where samples are difficult to place into subgroups or
runs where small quantities are run at a time.
There are several basic short run SPC techniques:
1. Nominals Charts
2. Individuals/Moving Range Charts
3. Moving Average/Moving Range Charts
4. Standardized Formula Charts
The Moving Average/Moving Range Chart technique is particularly well suited for
situations where control information is desired as soon as possible and there is a
relatively long time between sample collections. After considering the nature of wave
solder operations and the reflow machine sampling process, the Moving
Average/Moving Range Chart technique was incorporated into OvenRIDER SPC.
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Moving Average/Moving Range Chart Technique:
OvenRIDER SPC utilizes the standard Moving Average/Moving Range Charting
technique with a subgroup size of 2-6 that is selected by the user. The following steps
and figure illustrates the Moving Average/Moving Range calculations (using a group
size of two) that are used to construct the SPC chart.
Steps for Creating a Moving Average Moving Range Control Chart
1. Select the key variable to monitor.
2. Select the moving average group size. (We will use two in our example.)
3. Obtain your first sample and record it as sample 1 (X1).
4. Obtain your second sample and record it as sample 2 (X2).
5. Determine the X-bar and R values.
Moving Average formulas:
X=

X1 + X2
2

(Range)R=X - X
H L

6. Plot this value on the chart as subgroup 1.
7. Carry forward sample 2 into subgroup 2’s calculation. Obtain your third sample
and record it as sample 3. The averages of sample 2 and sample 3 form
subgroup 2.
8. Plot this value on the chart as subgroup 2.
9. Repeat for all the samples.
10 Calculate control limits using standard X-bar and R formulas for the appropriate
sample sizes. OR SPC uses range-based calculations for LCL and UCL.
11. Continue monitoring the process.
SAMPLE #
SAMPLE MEASUREMENTS
SUBGROUP VALUE

1
3
x
R

2
4
3.5
1

3
5
4.5
1

4
3
4
2

5
2
2.5
1

6
9
5.5
7

7
5
7
4

8
2
3.5
3

9
6
4
4

10
8
7
2

11
4
6
4

12
8
6
4

13
5
6.5
3

14
6
5.5
1

15
3
4.5
3

Figure A-1: Moving Average/Moving Range Subgroup Size 2 Calculations Chart
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16
3
3
0

Process Capability
A process capability index is a standard measure of how a process compares with its
specification limits—how a process is performing relative to how it is supposed to
perform. As opposed to the control chart, which shows detailed information about how
the data compares with control limits, a capability index is a summary of how the data
compares with the specification limits.
Two common capability indicators are Cp and CpK. These values are shown in the
Statistics Box on each SPC Worksheet.

Figure A-2

For both of the index values, the data used to determine them is dictated by the
subgroup size (N) chosen by the user. In the case where N=1, individual data is used—
for N>1, average data is used (x bar).
The figures below give a graphical representation of the concept of Cp and CpK. Notice
that in each graph, the same upper and lower specification limits (USL, LSL) are used.
The values of Cp and CpK will differ according to the data that is compared with those
specifications.
Depending on the particular process being monitored, the desired value for Cp and CpK
may differ. In general, however, a Cp and CpK of 1.33 or above is desired. This
assures that the process is not only capable of meeting the required specification limits,
but also has a built-in margin for error that may be needed in special circumstances. In
addition to targeting a certain minimum Cp and CpK, it is also desirable to have these
two values equal one another. This indicates that the process is well-centered between
the specification limits.
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Cp ≥ 1.33: Data tightly distributed.
Cpk ≥ 1.33: Data well inside spec limits.

Cp = 1.00: Data fills entire spec range.
Cpk = 1.00: Data fills entire spec range.

Cp > 1.00: Data tightly distributed. If it
were centered between the spec limits,
no data would lie beyond those limits.
Cpk < 1.00: Some data is outside the
spec limits.

Cp < 1.00: Data not tightly distributed. If
it were centered between the spec
limits, some data would still lie outside
those limits.
Cpk < 1.00: Some data is outside the
spec limits.
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The equations used to calculate the index values are as follows:

Cp =

USL − LSL
6 * ( Std .Dev.)

Cpk =

USL − x
3 * ( Std .Dev.)

OR

Cpk =

x − LSL
, whichever is less
3 * ( Std .Dev.)

As can be interpreted from the above equations, Cp gives an indication of how narrow
the data distribution is relative to the width of the specification limits. Essentially, it
indicates how well the process would be able to stay within the specified limits if the
data were perfectly centered between those limits.
CpK compares the widest half of the data distribution to the appropriate specification
limit. It indicates whether the process is capable of meeting the specification as
indicated by the “worst half” of the measurements. Unlike Cp, the CpK index measures
process capability without assuming the data is well-centered.
The figures below give a graphical representation of the concept of Cp and CpK. Notice
that in each graph, the same upper and lower specification limits (USL, LSL) are used.
The values of Cp and Cpk will differ according to the data that is compared with those
specifications.
Depending on the particular process being monitored, the desired value for Cp and CpK
may differ. In general, however, a Cp and CpK of 1.33 or above is desired. This
assures that the process is not only capable of meeting the required specification limits,
but also has a built-in margin for error that may be needed in special circumstances. In
addition to targeting a certain minimum Cp and CpK, it is also desirable to have these
two values equal one another. This indicates that the process is well-centered between
the specification limits.
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Appendix C: Measurement Definitions
This section defines how each solder machine parameter is measured and or
calculated:
PROCESS
SENSORS
(A, B & C)

AMBIENT SENSORS (A, B & C)

Figure C-1: Sensor Placements

M.O.L.E.
Temp: Internal temperature of the SuperM.O.L.E. Gold at the end of the run.
Batt: The battery voltage of the SuperM.O.L.E. Gold at the time of the last data sample.
Oven AMB
Start Temp: (A), (B) and (C) - Temperature of the ambient sensor (A), (B) and (C) at
the first data point measured after OvenRIDER is started.
Peak Avg.: (A), (B) and (C) - The highest zone temperature (Average) measured on
Ambient Sensor (A), (B) and (C)*.

* - Average zone temperature is the average of all temperature measurements
made over the interval that lies between 15% and 85% of the length of the zone
being averaged. This measurement reduces the effect of any zone boundary
temperature transitions, due to inter-zonal thermal drafts.

OvenRIDER® NL

♦153♦

Oven Process
Start Temp: (A) (B) and (C) - Temperature of Process Sensor (A) (B) and (C) first data
point measured at the start of zone 1 (Process origin).
Delta: (A) (B) and (C) - Temperature change seen by Process Sensor (A) (B) and (C)
from beginning of zone 1 (Process origin) and end of last zone.
(Tzone(n) end - Tzone1begin).
Conveyor Speed: Speed of conveyor in inches or centimeters per minute. Measured
from the difference between front and rear zone boundary sensors.
Zones: Number of zones detected or manually defined.
Zone 1
Time: Time spent in each zone.
Avg. Temp: (A) (B) and (C) - Average of the Ambient Sensor (A) (B) and (C)
temperatures within the zone.*
Process: (A) (B) and (C) - Temperature change seen by Process Sensor (A) (B) and
(C) from the beginning of the zone to the end. (Tend Tbegin).

* - Average zone temperature is the average of all temperature measurements
made over the interval that lies between 15% and 85% of the length of the zone
being averaged. This measurement reduces the effect of any zone boundary
temperature transitions, due to inter-zonal thermal drafts.
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Appendix D: OvenRIDER Accuracy and the Influencing Factors
There are two fundamental measurements the OvenRIDER NL measures: temperature
and time. The accuracy, resolution and range the OvenRIDER NL is capable of are
stated in the Specification section of the manual. The purpose of this paper is to show
how these specifications affect the reflow oven parameters presented in the
OvenRIDER SPC software.
Time Specifications
Measuring time by the OvenRIDER NL is influenced more by the log rate rather then the
overall accuracy of the timer. The OvenRIDER NL takes data at a log rate of 0.1sec.
Thus every reading of time has a resolution tolerance of ±0.1 second. The net effect on
time dependent variables is best illustrated on the graphs below. These include the 0.1
second resolution end the specified 1% accuracy of the M.O.L.E.’s clock.
Time in zones
The % effect that ±0.1 seconds has on the measured zone times decreases as the zone
time increases. To determine the maximum error you could see in zone time
measurements, locate the measured zone time on the X-axis of the graph and run
vertically to the curve. Now run horizontally to the left and find the % error on the Y-axis.
Clearly the maximum % error that 0.1 seconds has on the measured value increases
dramatically as your zone times approach 1.0 seconds, but practical zone times run
from 10 to 30 seconds or 2% to 5% error respectively.
Conveyor Speed
The % effect that ±0.1 seconds has on the measured conveyor speed increases with
the actual conveyor speed. To determine the maximum error you could see in conveyor
speed measurements, locate the measured speed (in/min) on the X-axis of the graph
and run vertically to the curve. Now run horizontally to the left and find the % error on
the Y-axis. This is the maximum % error of actual conveyor speed you could expect to
see. Typical errors run at about 1.3% at 25ft/min.
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Temperature Specifications
Absolute temperature accuracy is dependent on four basic factors:
1. The accuracy of the thermocouple sensor (T/C)
2. The accuracy of the Cold Junction Compensation sensor (CJC)
3. The accuracy of the overall Analog to Digital system (A/D)
4. The conformity to the International Practical Temperature Scale (IPTS)
Other factors could be mentioned here but they are either too small to be concerned
with or are “lumped” in with those mentioned above.
The maximum possible error for a given temperature reading is the sum of the errors
listed above. For the M.O.L.E. this maximum would be:
T/C ± 4°F + CJC ± 4.5°F + A/D ± 0.3°F + IPTS ± 0.1°F = ±8.9°F
This may seem extreme but it is the theoretical maximum error (see Specification in
Appendix A: Specifications). However, we calibrate each M.O.L.E. to ±1.8°F (1°C) at
212°F (100°C) and 1832°F (1000°C). With conformity to IPTS at 0.1°F and A/D error at
0.3°F, the practical maximum error would be (when using traceable voltage standards
as the calibration source):
± 1.8°F + IPTS ± 0.1°F + A/D ± 0.3°F = ±2.2°F
This leaves only the T/C error to deal with. The OvenRIDER NL Pallet uses “Standard
Limits of Error” T/Cs which have ±1.100°F or ±4 whichever is greater tolerance.
Practical use of these standard T/Cs shows that these tolerance limits are rarely
approached. Tighter tolerance T/Cs can be used at extreme cost, with a tolerance no
better then ±2°F. This small gain in accuracy is not worth the extra cost, considering the
temperature range being measured by the OvenRIDER NL (<500°F typically).
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Figure D-1: Conveyor Speed Error
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Figure D-2: Zone Time Error
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Appendix E: Pull-Down Menus & Toolbar Buttons
The dimmed menu commands are used in other worksheets.
Active menus for the Welcome and Guide Worksheets:

Active menus for the OvenRIDER Worksheet:

Active menus for the Spreadsheet Worksheet:

OvenRIDER® NL
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Active menus for the Profile Worksheet:

Active menus for the Admin(istration) Worksheet:

Active menus for the SPC Worksheets:
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OvenRIDER SPC Tool buttons:
3d View

Open

About

Overlay

Align Left

Peak Difference

Align Right

Prediction

Back (To Previous Data Run)

Print

Bold

Redo

Center

Read OvenRIDER Data

Copy

Save

Erase All

Slope

Erase Objects

Tolerance Band

First (Data Run)

Total Heat

Italic

Underline

Last (Data Run)

Undo

Magnify

OvenRIDER Settings

New

Zoom 100%

Next (Data Run Difference

Zoom In

Notes

Zoom Out
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Appendix F: OvenRIDER NL Options and Accessories
OvenRIDER NL Options
OvenRIDER NL Upgrade System
6.6 in. (167 mm) Wide Pallet
12 in. (305 mm) Wide Pallet
18 in. (457 mm) Wide Pallet
Custom widths, 6.6” to 18” (167 mm to 457 mm)
Included items:
• OvenRIDER pallet
• OvenRIDER User Guide
• OvenRIDER SPC software
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Part Number
E45-6836-05
E45-6836-15
E45-6836-25
E45-6836-35

• Start/Zones Magnet Kit [P&C]
• OvenRIDER Quick Reference Guide
• Carrying Case

OvenRIDER® NL

OvenRIDER NL Accessories:

Accessories:

Part Number

Rechargeable Power Pack for SuperM.O.L.E. Gold
Power Pack Charger, 110V
Power Pack Charger, 220V
Calendar/Clock Battery for SuperM.O.L.E. Gold
Sensor Battery
Sensor Magnet Kit for Electrovert Omni Flo Ovens (Ovens up to 12 zone)
Sensor Magnet Kit Type P (Ovens up to 12 zone)
Note: See illustrations below for clip types

E45-7647-30
E31-0900-25
E31-0900-21
F30-0041-00
F30-0048-00
E37-6836-91
E37-6836-92

OvenRIDER carrying case (18” maximum width pallet)
Spare OvenRIDER comm plug (engages RIDER mode)

E37-6836-94
Y20-2848-60

Manuals:
OvenRIDER NL Users Guide
OvenRIDER NL Quick Reference Guide

A45-6836-00
A41-6836-16

Miscellaneous:
Upgrade existing SuperM.O.L.E. Gold to RIDER-Ready
includes calibration
SuperM.O.L.E. Gold to PC Interface Cable
Extended warranty, 1 year. Includes 1 calibration

Magnet Clip Type “Omni Flo”

OvenRIDER® NL

E31-0900-46
Y20-2848-04
A00-6836-00

Magnet Clip Type “P”
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